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ABSTRAK 

Bella Junita. Respon Struktur Bangunan Tinggi Dengan Variasi Penempatan 

Outrigger Terhadap Beban Lateral (Studi Kasus: Bangunan Tower A St. 

Moritz Panakkukang). Skripsi. Jakarta: Program Studi Pendidikan Teknik 

Bangunan, Fakultas Teknik, Universitas Negeri Jakarta, 2017. Dosen Pembimbing: 

Drs.Prihantono, ST, M. Eng dan Lenggogeni, MT. 

Penelitian ini bertujuan untuk menganalisis respon bangunan tinggi terhadap beban 

lateral dengan menggunakan variasi penempatan outrigger pada bangunan tinggi 

yang tidak beraturan vertikal lantai lunak dan massa. 

Objek pada penelitian adalah St. Moritz Panakukang Tower A. merupakan 

bangunan tinggi yang menggunakan outrigger sebagai penahan gaya lateral pada 

lantai yang memiliki ketidakberaturan vertikal lantai lunak sehingga menyebabkan 

ketidakberaturan massa. Perilaku struktur bangunan dapat dilihat dari respon 

struktur berupa gaya geser dasar, periode getar stuktur, simpangan total dan 

simpangan antar tingkat. Metode analisis terhadap beban gempa menggunakan 

analisis dinamis respon spektrum berdasarkan SNI 1726:2012 dengan bantuan 

software ETABS versi 9.7.1. 

Hasil penelitian ini menunjukkan bahwa penggunaan variasi penempatan outrigger 

pada bangunan tinggi dengan ketidakberaturan vertikal lantai lunak dan massa 

mempengaruhi respon stuktur terhadap beban gempa. Penempatan outrigger pada 

lantai lunak dengan ketidakberaturan massa dapat menurunkan nilai base shear 

yang disebabkan oleh membesarnya nilai periode bangunan. Penempatan outrigger 

pada 3/4h bangunan menunjukkan respon yang paling baik dimana mampu 

memperbesar nilai base shear dan menurunkan nilai displacement pada arah X 

sebesar 15,08% dan arah Y sebesar 8,21%. Oleh karena itu, penempatan outrigger 

pada bangunan tinggi harus dipertimbangkan dengan baik agar penggunaannya 

dapat meningkatkan perilaku sruktur. 

Kata Kunci: Outrigger, Bangunan Tinggi, Ketidakberaturan Lantai Lunak, 

Ketidakberaturan Massa, Gaya Geser Dasar, Simpangan. 
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ABSTRACT 

Bella Junita. Response of High Rise Building Structure With Variation Outrigger 

Placement Under Seismic Load (Case Study: Tower A of St. Moritz 

Panakkukang). Bachelor Thesis. Building Engineering Education Study Program, 

Faculty of Engineering, State University of Jakarta, 2018. Supervisors: 

Prihantono, M. Eng and Lenggogeni, MT. 

The purpose of this research was to know high rise buildings response due to the 

earthquake loads by applying outrigger system variation on soft story irregularities 

and mass irregularities building. 

The building case in this research used St. Morits Panakkuang Tower A. is a tall 

building that uses an outrigger as a lateral force retainer on a floor that has soft 

story vertical irregularities causing mass irregularities. Behavior of building 

structure can be seen from structure response in the form of base shear force, 

period of vibration structure, total deviation and inter-level deviation. Analysis 

method for earthquake load using dynamic analysis of spectrum response based on 

SNI 1726: 2012 with the help of ETABS software version 9.7.1 

 

The results of this study indicate that the use of outrigger placement variations in 

tall buildings with soft floor vertical irregularities and mass affects the structural 

response to earthquake loads. The placement of the outrigger on the soft floor with 

mass irregularities may decrease the base shear value caused by the enlarged value 

of the building period. Outrigger placement at 3 / 4h of the building shows the best 

response which is able to enlarge the base shear value and decrease the 

displacement value in X direction by 15,08% and Y direction equal to 8,21%. 

Therefore, outrigger placement in high buildings should be well considered so that 

their use can improve the structural behavior. 

 

Keywords: Outrigger, High Rise Building, Soft Floor Irregularities, Mass 

Irregularities, Base Shear, Displcement. 

 

  



 

iv 

 

 



 

v 

 

 



 

vi 

 

KATA PENGANTAR 

Puji dan syukur penulis panjatkan atas kehadirat Allah SWT yang telah 

memberikan nikmat, karunia serta hidayah-Nya, sehingga penulis diberikan 

kesehatan dan kemudahan dalam menyelesaikan skripsi dengan judul “Respon 

Struktur Bangunan Tinggi Dengan Variasi Penempatan Outrigger Terhadap Beban 

Lateral” sebagai salah satu syarat untuk memperoleh gelar sarjana Pendidikan. 

Dalam penyusunan skripsi ini penulis mendapatkan banyak bantuan dan 

dukungan dari berbagai pihak, oleh karena itu penulis mengucapkan terima kasih 

yang sebesar-besarnya kepada: 

1. Kedua orang tua penulis yang selalu memberikan doa dan dukungannya. 

2. Drs. Prihantono, ST, M. Eng sebagai dosen pembimbing 1 yang telah 

memberikan bimbingan sepenuhnya sampai skripsi ini dapat diselesaikan 

dengan baik. 

3. Lenggogeni, MT sebagai dosen pembimbing metodologi yang telah 

memberikan bimbingan sampai akhir penulisan skripsi ini. 

4. R. Eka Murtinugraha, M. Pd sebagai Ketua Program Studi Pendidikan 

Teknik Bangunan, Fakultas Teknik, Universitas Negeri Jakarta. 

5. Sittati Musalamah, MT dan Anisah, MT selaku dosen penguji. 

6. Teman-teman seperjuangan program studi pendidikan teknik bangunan B 

angkatan 2013.  

7. Bapak Anton selaku karyawan PT. Pembangunan Perumahan yang telah 

mengizinkan penulis melakukan penelitian pada Proyek St. Morits 

Panakkukang. 

8. Serta pihak-pihak lain yang membantu penulis menyelesaikan skripsi ini 

secara langsung maupun tidak langsung. 

Penulis menyadari bahwa dalam penyusunan skripsi ini masih mempunyai 

banyak kekurangan karena keterbatasan pengetahuan penulis. Oleh karena itu, 

saran dan kritik yang membangun sangat diharapkan demi kesempurnaan skripsi 

ini. Akhir kata semoga skripsi ini dapat berguna dan bermanfaat bagi penulis dan 

pembaca. 

       Jakarta, Februari 2018 

 

        Penulis 

 



 

vii 

 

DAFTAR ISI 

ABSTRAK ............................................................................................................ ii 

ABSTRACT.......................................................................................................... iii 

LEMBAR PENGESAHAN ................................................................................ iv 

HALAMAN PERNYATAAN .............................................................................. v 

KATA PENGANTAR.......................................................................................... vi 

DAFTAR ISI ....................................................................................................... vii 

DAFTAR GAMBAR ........................................................................................... ix 

DAFTAR TABEL ................................................................................................. x 

DAFTAR LAMPIRAN ....................................................................................... xi 

BAB I  PENDAHULUAN ................................................................................ 1 

1.1 Latar Belakang Masalah .................................................................. 1 

1.2 Identifikasi Masalah ........................................................................ 4 

1.3 Pembatasan Masalah ....................................................................... 5 

1.4 Rumusan Masalah ........................................................................... 6 

1.5 Tujuan Penelitian ............................................................................ 6 

1.6 Kegunaan Penelitian........................................................................ 6 

BAB II KAJIAN TEORI ................................................................................. 8 

2.1 Landasan Teori ................................................................................ 8 

2.1.1 Bangunan Tingkat Tinggi ...................................................... 8 

2.1.2 Ketidakberaturan Pada Bangunan ........................................ 12 

2.1.3 Sistem Penahan Gaya Lateral .............................................. 14 

2.1.3.1 Dinding Geser .......................................................... 14 

2.1.3.2 Sistem Outrigger ...................................................... 16 

2.1.4 Teori Gempa......................................................................... 24 

2.1.4.1 Perilaku Struktur Akibat Beban Gempa ................... 27 

2.1.4.2 Kategorisasi Desain Seismik .................................... 33 

2.1.4.3 Metode Analisa Respon Spektrum ........................... 34 

2.1.5 Pembebanan Struktur ........................................................... 41 

2.1.6 Software ETABS .................................................................. 44 

2.2 Penelitian Relevan ......................................................................... 46 

2.3 Kerangka Berpikir ......................................................................... 49 



 

viii 

 

2.4 Hipotesis Penelitian ....................................................................... 50 

BAB III METODOLOGI PENELITIAN ...................................................... 51 

3.1 Waktu dan Tempat Penelitian ....................................................... 51 

3.2 Subjek Penelitian ........................................................................... 51 

3.3 Ketidakberaturan Vertikal Pada Bangunan ................................... 54 

3.3.1 Ketidakberaturan Lantai Lunak ............................................ 54 

3.3.2 Ketidakberaturan Massa ....................................................... 56 

3.4 Variasi Pemodelan Struktur .......................................................... 57 

3.5 Pembebanan Struktur .................................................................... 58 

3.5.1 Beban Mati ........................................................................... 59 

3.5.2 Beban Hidup ......................................................................... 59 

3.5.3 BebanGempa ........................................................................ 60 

3.5.4 KombinasiPembebanan ........................................................ 62 

3.6 Metodologi Penelitian ................................................................... 64 

3.7 Teknik Analisis Data ..................................................................... 65 

BAB IV HASIL PENELITIAN DAN PEMBAHASAN ............................... 66 

4.1 Hasil Penelitian ............................................................................. 66 

4.1.1 Base Shear ............................................................................ 66 

4.1.2 Displacement ........................................................................ 68 

4.1.3 Story Drift ............................................................................. 69 

4.2 Pembahasan ................................................................................... 70 

4.2.1 Analisa Base Shear .............................................................. 70 

4.2.2 Analisa Displacement ........................................................... 73 

4.2.3 Analisa Story Drift ............................................................... 81 

4.3 Analisa Keseluruhan ..................................................................... 84 

4.4 Keterbatasan Penelitian .................................................................86 

BAB V KESIMPULAN DAN SARAN ......................................................... 88 

5.1 Kesimpulan ................................................................................... 88 

5.2 Saran .............................................................................................. 89 

DAFTAR PUSTAKA .......................................................................................... 90 

 

 

  



 

ix 

 

DAFTAR GAMBAR 

Gambar 1.1    Tampak Atas Outrigger .................................................................... 2 

Gambar 1.2    Denah Outrigger Pada Lantai 26 ...................................................... 4 

Gambar 2.1    Klasifikasi Bangunan Tinggi Material Utama Baja ......................... 9 

Gambar 2.2    Klasifikasi Bangunan Tinggi Material Utama Beton ....................... 9 

Gambar 2.3    Sistem-sistem Bangunan Tinggi..................................................... 11 

Gambar 2.4    Efek Penggunaan Outrigger pada Bangunan Tinggi ..................... 18 

Gambar 2.5    Outrigger Pada Bangunan Tingkat Tinggi ..................................... 18 

Gambar 2.6   Transfer Gaya dalam Sistem Outrigger Truss Yang Konvensional 19 

Gambar 2.7    Bangunan Tingkat Tinggi Dengan Belt Truss ................................ 20 

Gambar 2.8    (a) Transfer Overturning Moment dari Core ke Diafragma Lantai (b) 

Transfer Gaya dari Diafragma Lantai ke Kolom Eksterior ............ 21 

Gambar 2.9    Reaksi Rangka Inti dengan Belt Truss ........................................... 22 

Gambar 2.10  Lempeng Tektonik di Indonesia ..................................................... 26 

Gambar 2.11  Perilaku Struktur terhadap Beban Lateral ...................................... 27 

Gambar 2.12  Parameter Ss ................................................................................... 36 

Gambar 2.13  Parameter S1 ................................................................................... 36 

Gambar 2.14  Grafik Spektrum Respons Desain .................................................. 38 

Gambar 3.1     Kolom, Balok, dan Pelat lantai Basement 1 .....................................51 

Gambar 3.2    Variasi Penempatan Outrigger Pada Struktur ................................ 58 

Gambar 3.3    Kurva Respon Spektrum ................................................................ 62 

Gambar 3.4   Displacement Arah X  ..................................................................... 65 

Gambar 3.5    Displacement Arah Y ..................................................................... 65 

Gambar 3.6    Diagram Alur Penelitian .................................................................65 

Gambar 3.7    Diagram Alur Pemodelan Struktur .................................................65 

Gambar 4.1    Base Shear Arah X dan Arah Y.......................................................70 

Gambar 4.2    Periode Seluruh Pemodelan Struktur ............................................. 71 

Gambar 4.4    Nilai Displacement Maksimum Arah Y ......................................... 74 

Gambar 4.5    Nilai Displacement Tanpa Outrigger Arah X dan Arah Y ............ 75 

Gambar 4.6    Nilai Displacement Variasi 1 Pada Arah X dan Arah Y ................ 77 

Gambar 4.7    Nilai Displacement Eksisting Pada Arah X dan Arah Y ................ 78 

Gambar 4.8   Nilai Displacement Variasi 2 Pada Arah X dan Arah Y ................. 79 

Gambar 4.9   Nilai Displacement Variasi 3 Pada Arah X dan Arah Y ................. 80 

Gambar 4.10  Nilai Story Drift Pada Arah X ........................................................ 83 

Gambar 4.11  Nilai Story Drift Pada Arah Y ........................................................ 84 

 

  



 

x 

 

DAFTAR TABEL 

Tabel 2.1    Ketidakberaturan Vertikal pada Bangunan ........................................ 12 

Tabel 2.2    Simpangan Antar Lantai Ijin (∆a
a.b) ................................................... 29 

Tabel 2.3  Kategori Resiko Bangunan Gedung dan Non Gedung untuk Beban 

Gempa ................................................................................................ 29 

Tabel 2.4    Faktor Keutamaan Gempa ................................................................. 31 

Tabel 2.5    Koefisien Untuk Batas Atas Pada Perioda Yang Dihitung ................ 32 

Tabel 2.6    Nilai Parameter Perioda Pendekatan Ct dan x .................................... 33 

Tabel 2.7  Kategori Desain Seismik Berdasarkan Parameter Respon Percepatan 

Pada Perioda Pendek ......................................................................... 33 

Tabel 2.8  Kategori Desain Seismik Berdasarkan Parameter Respon Percepatan 

Pada Perioda 1 Detik ......................................................................... 34 

Tabel 2.9    Prosedur Analisis yang boleh digunakan ........................................... 34 

Tabel 2.10  Kelas Situs.......................................................................................... 36 

Tabel 2.11  Koefisien situs, Fa .............................................................................. 37 

Tabel 2.12  Koefisien situs, Fv .............................................................................. 37 

Tabel 2.13  Faktor Modifikasi Respons ................................................................ 40 

Tabel 2.14  Variasi Penempatan Outrigger........................................................... 48 

Tabel 3.1    Dimensi Kolom ..................................................................................52 

Tabel 3.2    Dimensi Balok.................................................................................... 52 

Tabel 3.3    Dimensi Pelat ..................................................................................... 53 

Tabel 4.1    Nilai Base Shear Sebelum Terkoreksi ...............................................66 

Tabel 4.2    Nilai Faktor Skala Setelah Koreksi .................................................... 67 

Tabel 4.3    Nilai Base Shear Setelah Koreksi ...................................................... 68 

Tabel 4.4    Nilai Displacement Arah X ................................................................ 69 

Tabel 4.5    Nilai Displacement Arah Y ................................................................ 69 

Tabel 4.6    Nilai Story Drift Arah X..................................................................... 69 

Tabel 4.7    Nilai Story Drift Arah Y..................................................................... 69 

Tabel 4.8    Massa Struktur Seluruh Pemodelan ................................................... 72 

Tabel 4.9    Kontrol Dipslacement ........................................................................ 80 

 

  



 

xi 

 

DAFTAR LAMPIRAN 

Lampiran 1. Evaluasi Nilai Base Shear dan Perhitungan Faktor Skala Terkoreksi 

....................................................................................................... 92 

Lampiran 2.  Nilai Displacement ........................................................................ 97 

Lampiran 3. Nilai Story Drift ........................................................................... 101 

Lampiran 4.  Kontrol Story Drift ...................................................................... 105 

Lampiran 5. Gambar Proyek ............................................................................109 

Lampiran 6. Modul Penggunaan ETABS ........................................................ 111 

Lampiran 7. Surat Administrasi ...................................................................... 131



 

1 

 

BAB I 

  PENDAHULUAN 

1.1 Latar Belakang Masalah 

Kemajuan di bidang teknik sipil pada abad ini terlihat dari semakin 

banyaknya negara-negara yang berlomba membangun bangunan-bangunan tingkat 

tinggi. Salah satu alasan pembangunan gedung tingkat tinggi ialah keterbatasan 

lahan. Seperti di kota-kota besar dengan jumlah penduduk yang tinggi maka 

kebutuhan tempat tinggal akan meningkat namun ketersediaan lahan tidak 

bertambah. Untuk mengatasi keterbatasan lahan yang tersedia, meninggikan 

struktur bangunan merupakan salah satu solusi. Semakin banyak lantai maka 

semakin banyak pula ruang yang tersedia. 

Pembangunan bangunan tinggi sangat rentan terhadap bahaya beban lateral 

seperti beban angin dan gempa bumi. Mengingat bahwa Indonesia merupakan 

negara dengan aktivitas gempa tektonik yang tinggi karena terletak pada 4 lempeng 

tektonik utama yaitu lempeng Eurasia, Indo-Australia, Pasifik dan Filipina, maka 

perlu direncanakan sistem penahan gaya lateral akibat gempa dalam merencanakan 

bangunan tinggi. Hal ini dilakukan agar gedung yang direncanakan mampu 

menahan gaya lateral yang terjadi akibat gempa.  

Inovasi terus dikembangkan dalam mendesain bangunan tinggi untuk 

menahan gaya lateral akibat gempa. Pengaku gaya lateral yang lazim digunakan 

adalah portal penahan momen, dinding geser atau rangka pengaku (bracing) 

(Juwana, 2005). Umumnya sistem penahan gaya lateral yang digunakan adalah 

dinding geser. Seiring perkembangan zaman, banyak sistem desain penahan gaya 
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lateral yang digunakan pada bangunan tingkat tinggi. Salah satunya dengan 

penerapan sistem outrigger pada bangunan tinggi. 

Outrigger adalah suatu struktur tambahan berbentuk rangka batang 

berdimensi besar, yang dipasang menghubungkan core dengan kolom-kolom 

eksterior suatu bangunan gedung. Pemakaiannya telah cukup terbukti efektif dalam 

mengurangi simpangan lateral suatu bangunan tingkat tinggi, khususnya pada 

bangunan yang memiliki lantai lebih dari 40 lantai  (Adhy, 2000). Outrigger 

menghubungkan corewall dengan kolom yang terluar pada bangunan seperti pada 

gambar 1.1. 

 

Gambar 1. 1 Tampak Atas Sistem Outrigger 

Penggunaan outrigger dapat menambah kekakuan struktur gedung dimana 

kekakuan tersebut dapat mengurangi drift maksimum struktur dan periode struktur 

(Syahriar, 2012). Outrigger yang digunakan pada bangunan tinggi tidak di pasang 

di setiap lantai melainkan disesuaikan dengan kebutuhan dan perencanaan. 

Umumnya outrigger dapat dipasang hanya pada satu lantai atau lebih (Angerik, 

2009). McNabb dkk (1975) membenarkan penelitian Taranath (1974) mengenai 

lokasi optimal outrigger (0,445h dari atap bangunan untuk satu outrigger) dan 

menunjukkan lokasi optimal untuk dua outrigger pada 0,312h dan 0,685h dari atap 

(Herath, 2009). N. Herath et al (2009) menyatakan bahwa lokasi optimum outrigger 
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gedung 50 lantai dengan konstruksi beton bertulang diberi beban gempa dan 

dianalisis dengan respon spektrum terletak pada 0,44-0,48 tinggi bangunan dari 

dasar bangunan. Kesamaan ketiga penelitian diatas adalah gedung yang digunakan 

sebagai model merupakan gedung beraturan. Pengaruh gaya gempa akan berbeda 

jika diaplikasikan terhadap bangunan beraturan dan tidak beraturan. Kinerja 

struktur yang dihasilkan untuk gedung tidakberaturan akan berbeda dengan gedung 

beraturan untuk intensitas beban gempa yang sama, misalnya jika dibandingkan 

terhadap simpangan (displacement) dan simpangan antar lantai (drift) (Purba, 

2014).   

Salah satu proyek konstruksi bangunan tingkat tinggi di Indonesia yang 

menggunakan sistem tambahan outrigger adalah Proyek St. Moritz Panakukang. 

Proyek ini merupakan salah satu bangunan tinggi yang terdiri dari 55 lantai 

mengunakan shearwall di sepanjang bangunan dan menggunakan sistem tambahan 

berupa outrigger sebagai penahan gaya lateral pada lantai 26. Penempatan 

outrigger pada proyek ini berdasarkan teori dan hasil penelitian ahli sudah ideal 

jika didasarkan pada pendapat para ahli mengenai posisi optimum outrigger pada 

bangunan tinggi beraturan sedangkan proyek ini diduga mempunyai 

ketidakberaturan vertikal. Ketidakberaturan vertikal umumnya ditandai dengan 

adanya perbedaan tinggi antar lantai struktur, massa bangunan yang berubah serta 

konfigurasi bangunan. Pada lampiran 3 terlihat perbedaan ketinggian antar lantai 

bangunan. Pada gambar 1.2 outrigger menghubungkan seluruh kolom yang ada 

pada lantai 26 tidak hanya antara corewall dan kolom terluar bangunan. 

Penempatan outrigger tentu mempengaruhi seberapa besar gaya lateral yang 

ditahan. 
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Gambar 1. 2 Tampak Atas Sistem Outrigger di Lantai 26 

Berdasarkan uraian diatas perlu dilakukan analisis terhadap perilaku 

struktur pada proyek St. Moritz Panakukang bangunan tinggi dengan 

ketidakberaturan vertikal lantai lunak yang menerima beban gempa dengan variasi 

penempatan outrigger. Outrigger akan ditempatkan bervariasi pada lantai-lantai 

lainnya selain lantai 26 yaitu seperempat dan tiga perempat tinggi bangunan. 

Diharapkan penelitian ini akan memberikan informasi perilaku struktur yang 

mempunyai ketidakberaturan vertikal dengan beberapa variasi penempatan 

outrigger terhadap beban gempa. Diharapkan penelitian ini juga akan memberikan 

saran lokasi optimum untuk outrigger pada proyek St. Moritz Panakukang.  

1.2 Identifikasi Masalah 

Berdasarkan latar belakang masalah diatas maka identifikasi masalah pada 

penelitian ini adalah  

1. Bagaimana respon struktur Tower A St. Moritz Panakukang dengan outrigger 

pada lantai 26 terhadap beban gempa. 
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2. Bagaimana perilaku struktur Tower A St. Moritz Panakukang terhadap beban 

lateral jika outrigger pada kondisi eksisting dihilangkan. 

3. Bagaimana perilaku struktur dengan ketidakberaturan vertikal lantai lunak dan 

ketidakberaturan massa terhadap beban gempa jika outrigger diletakkan di 

seperempat tinggi bangunan, tiga perempat tinggi bangunan dan pada atap 

bangunan.   

4. Variasi mana dari tiga variasi penempatan outrigger yang mempunyai 

displacement paling kecil pada proyek St. Moritz Panakukang. 

1.3 Pembatasan Masalah 

Agar penelitian yang akan dilakukan lebih terarah maka dibuat pembatasan 

masalah antara lain: 

1. Bangunan yang ditinjau adalah bangunan tower A pada proyek St. Moritz 

Panakukang Makassar 55 lantai yang terdiri dari hotel dan apartemen dengan 

konstruksi beton bertulang. 

2. Struktur gedung menggunakan struktur beton bertulang dengan Sistem Rangka 

Pemikul Momen Khusus (SRPMK) shearwall. 

3. Data yang digunakan merupakan gambar konstruksi proyek St. Moritz 

Panakukang. 

4. Dalam proses Analisa akan terdapat variasi outrigger dihilangkan dan tiga 

variasi penempatan outrigger pada bangunan. Variasi 1 penempatan outrigger 

pada 1/2h bangunan, variasi 2 penempatan outrigger pada 3/4h bangunan dan 

variasi 3 penempatan outrigger pada atap bangunan. 

5. Panjang outrigger yang digunakan berubah pada variasi penempatan outrigger 

3/4h dan atap bangunan mengikuti ketinggian pada masing-masing lantai. 
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6. Beban lateral yang diperhitungkan hanya beban gempa yang berpedoman pada 

SNI 1726:2012.  

7. Analisa struktur dilakukan dengan pemodelan 3 dimensi menggunakan 

software ETABS v.9.7.1 dengan model analisis respon spektrum. 

8. Respon struktur yang dianalisa ditinjau dari parameter displacement, story drift, 

base shear. 

1.4 Rumusan Masalah 

Berdasarkan latar belakang masalah dan identifikasi masalah diatas maka 

perumusan masalah dalam penelitian ini adalah “Bagaimana respon struktur 

bangunan tinggi yang mempunyai ketidakberaturan vertikal dengan beberapa 

variasi penempatan outrigger pada bangunan Tower A St. Moritz Panakukang 

terhadap beban gempa ditinjau dari parameter base shear, simpangan dan story 

drift?”. 

1.5 Tujuan Penelitian 

Tujuan penelitian ini adalah mengetahui respon struktur pada bangunan 

Tower A St. Moritz Panakukkang yang mempunyai ketidakberaturan vertikal 

menggunakan beberapa variasi penempatan outrigger sebagai penahan gaya gempa 

dengan parameter displacement, story drift, base shear. Serta mengetahui posisi 

optimum outrigger berdasarkan parameter-parameter tersebut. 

1.6 Kegunaan Penelitian 

Penelitian ini diharapkan dapat memberikan manfaat untuk berbagai pihak 

yang berhubungan dengan dunia Teknik sipil baik secara teoritis maupun praktis. 

Adapun manfaat yang bisa didapatkan dari oenelitian ini antara lain: 
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1. Kegunaan Teoritis 

Penelitian ini diharapkan menambah wawasan dan pengetahuan pembaca 

dibidang teknik sipil tentang respon struktur pada bangunan tinggi dengan 

ketidakberaturan vertikal lantai lunak dan ketidakberaturan massa yang 

menggunakan outrigger sebagai penahan gaya lateral akibat gempa.   

2. Kegunaan Praktis 

Penelitian ini diharapkan dapat digunakan sebagai tambahan informasi bagi 

kalangan masyarakat untuk perencanaan ke depannya bagaimana penempatan 

outrigger dapat mempengaruhi respon struktur bangunan tinggi yang 

mempunyai ketidakberaturan vertikal terhadap beban gempa.
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BAB II 

KAJIAN PUSTAKA 

2.1 Landasan Teori 

2.1.1 Bangunan Tingkat Tinggi 

Bangunan tingkat tinggi didefinisikan sebagai bangunan yang 

ketinggiannya menciptakan kondisi pada desain, pembangunan dan penggunaanya 

lebih maksimal daripada bangunan biasa pada waktu dan tempat tertentu. Para 

insiyur teknik sipil khususnya ahli struktur harus mengetahui dan menyadari 

pentingnya suatu sistem dari struktur dapat menahan beban yang bekerja secara 

lateral apabila telah dikategorikan jenis sistem struktural bangunan tingkat tinggi 

(Angerik, 2009). 

Di Indonesia tahun 1970-an dimana stabilitas politik mulai terbentuk dan 

perekonomian Indonesia bertambah pesat, pembangunan gedung-gedung tinggi 

bermunculan di Jakarta. Selain Hotel Indonesia yang dibangun Jepang sebagai 

kompensasi penjajahannya, bermunculan pula gedung tinggi lainnya seperti Wisma 

Nusantara (30 lantai), Wisma Antara, Hongkong Bank, Hotel Mandarin Hotel 

Hilton, Ratu Plaza dan lain-lain. Kebanyakan gedung-gedung tinggi dibangun 

sepanjang poros Thamrin-Sudurman, ditunjang dengan infrastruktur Jakarta yang 

terus ditata ke arah yang lebih baik (Sukamta, 2010).  

Pada tahun 1965, Fazlur Khan menyadari bahwa hirarki dari sistem struktur 

dapat dikategorikan dengan tujuan menjadi pendekatan yang efektif untuk penahan 

beban lateral. Tipe yang pertama merupakan sistem penahan momen yang efisien 

untuk gedung bertingkat 20 hingga 30 lantai. Tipe berikutnya merupakan generasi 

dari sistem tubular dengan efisiensi dari kantilever yang tinggi. Tampilan bagian 
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dari sistem ini terus dimoderenisasi secara periodik dalam jangka waktu tertentu 

apabila ada sistem baru yang ditemukan dan dikembangkan dalam perencanaan 

bangunan tingkat tinggi (Angerik, 2009). Fazlur Khan mengklasifikasikan sistem 

bangunan tingkat tinggi berdasarkan material utama yang digunakan seperti pada 

gambar 2.1 dengan material utama baja dan gambar 2.2 dengan material utama 

beton (Ali, 2007) .  

 

Gambar 2. 1 Klasifikasi Bangunan Tinggi Material Utama Baja 
(Sumber: Ali, 2007) 

 

Gambar 2. 2 Klasifikasi Bangunan Tinggi Material Utama Beton 
(Sumber: Ali, 2007) 
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Perpaduan dari unsur-unsur struktur dasar seperti kolom, balok, dinding dan 

plat akan membentuk struktur tulang dari bangunan. Sistem-sistem bangunan tinggi 

pendukung beban yang lazim dijumpai diantaranya (Schueller, 2001): 

1. Dinding Pendudukung Sejajar (Parallel Bearing Walls).  

2. Inti dan Dinding Pendukung Fasade (Core and Façade Bearing Walls) 

3. Boks Berdiri Sendiri (Self Supporting Boxes) 

4. Plat Kantilever (Cantilevered Slab) 

5. Plat Rata (Flat Slab) 

6. Interparsial (Interpartial) 

7. Gantung (Suspension) 

8. Rangka Selang Seling (Straggered Truss) 

9. Rangka Kaku (Rigid Truss) 

10. Rangka Kaku dan Inti (Rigid Frame and Core) 

11. Rangka Truss (Trussed Frame) 

12. Rangka Belt-Trussed dan Inti (Belt-Trussed Frame and Core) 

Belt truss mengikat kolom fasade ke inti sehingga meniadakan aksi terpisah 

rangka dan inti. Pengakuan ini dinamai cap trussing apabila barada pada bagian 

atas bangunan, dan belt trussing apabila berada di bagian bawahnya. 

13. Tabung Dalam Tabung (Tube In Tube) 

14. Kumpulan Tabung (Bandled Tube) 

Dalam penelitian ini sistem bangunan tinggi pada proyek St. Moritz 

Panakkukang adalah rangka kaku dan inti. Rangka kaku beraksi terhadap beban 

lateral, terutama melalui lentur balok dan kolom. Perilaku demikian berakibat 

ayunan (drift) lateral yang besar pada bangunan dengan ketinggian tertentu. Akan 
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tetapi, apabila dilengkapi dengan struktur inti, ketahanan lateral akan sangat 

meningkat karena interaksi inti dan rangka. Sistem inti ini memuat sistem-sistem 

mekanis dan transportasi vertikal. 

 

 

 

Gambar 2. 3 Sistem-sistem Bangunan Tinggi 
 (Sumber: (Schueller, 2001)) 
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2.1.2 Ketidakberaturan Pada Bangunan 

Pengaruh gaya gempa akan berbeda jika diaplikasikan terhadap bangunan 

beraturan dan tidak beraturan. Kinerja struktur yang dihasilkan untuk gedung tidak 

beraturan akan berbeda dengan gedung beraturan dengan intentitas beban yang 

sama, misalnya jika dibandingkan terhadap simpangan (displacement), simpangan 

antar lantai (drift), dan penulangannya (Purba, 2014). Pada peraturan perencanaan 

ketahanan gempa SNI 1726 2012 diatur mengenai ketidakberaturan struktur salah 

satunya yaitu ketidakberaturan vertikal. Menurut SNI 1726 2012, struktur bangunan 

yang mempunyai satu atau lebih tipe ketidakberaturan harus dianggap mempunyai 

ketidakberaturan vertikal. Tipe tipe ketidakberaturan vertikal pada struktur seperti 

pada tabel 2.1. 

Tabel 2. 1 Ketidakberaturan Vertikal pada Bangunan 

Tipe Tipe dan pejelasan ketidakberaturan Ilustrasi 

1a 

Ketidakberaturan Kekakuan Tingkat 

Lunak, didefinisikan ada jika terdapat 

suatu tingkat dimana kekakuan 

lateralnya kurang dari 70% kekakuan 

lateral tingkat di atasnya atau kurang 

dari 80% kekakuan rata-rata tiga 

tingkat di atasnya. 

 

 

 
Kekakuan: 

𝐴 < 70%𝐵 𝑎𝑡𝑎𝑢 

𝐴 < 80% (
𝐵 + 𝐶 + 𝐷

3
) 

1b 

Ketidakberaturan Kekakuan Tingkat 

Lunak Berlebihan, didefinisikan ada 

jika terdapat suatu tingkat dimana 

kekakuan lateralnya kurang dari 60% 

kekakuan lateral tingkat di atasnya atau 

kurang dari 70% kekakuan rata-rata 

tiga lantai di atasnya. 

 

 

 
Kekakuan: 

𝐴 < 70%𝐵 𝑎𝑡𝑎𝑢 

𝐴 < 80% (
𝐵 + 𝐶 + 𝐷

3
) 
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2 

Ketidakberaturan Berat (Massa), 

didefinisikan ada jika massa efektif 

semua tingkat lebih dari 150% massa 

efektif tingkat di dekatnya. Atap yang 

lebih ringan dari lantai di bawahnya 

tidak perlu ditinjau. 
 

3 

Ketidakberaturan Geometri Vertikal, 

didefinisikan ada jika dimensi 

horizontal sistem penahan gaya gempa 

di semua tingkat lebih dari 130% 

dimensi horizontal sistem penahan 

gaya gempa di tingkat di bawahnya. 

 
 

4 

Diskontinuitas Arah Bidang dalam 

Ketidakberaturan Elemen Penahan 

Gaya Lateral Vertikal, didefinisikan 

ada jika pergeseran arah bidang elemen 

penahan gaya lateral lebih besar dari 

panjang elemen itu atau terdapat 

reduksi kekakuan elemen oenahan di 

tingkat di bawahnya. 

 
 

5a 

Diskontinuitas dalam Ketidakberaturan 

Kuat Lateral Tingkat, didefinisikan ada 

jika kuat lateral tingkat kurang dari 

80% kuat lateral tingkat di atasnya. 

Kuat lateral tingkat adalah kuat lateral 

total semua elemen penahan 

seismikmyang berbagi geser tingkat 

untuk arah yang ditinjau. 

 
 

5b 

Diskontinuitas dalam Ketidakberaturan 

Kuat Lateral Tingkat Berlebihan, 

didefinisikan ada jika kuat lateral 

tingkat kurang dari 65% kuat lateral 

tingkat di atasnya. 

 

 
Sumber: Aplikasi SNI 1726:2012 for Dummies 
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2.1.3 Sistem Penahan Gaya Lateral 

Hal yang paling penting pada struktur bangunan tinggi adalah stabilitas dan 

kemampuan untuk menahan gaya lateral, baik yang disebabkan oleh angin maupun 

gempa bumi. Beban angin lebih terkait pada dimensi ketinggian bangunan, 

sedangkan beban gempa lebih terkait pada massa bangunan. Kolom pada bangunan 

tinggi perlu diperkokoh dengan sistem pengaku untuk dapat menahan gaya lateral, 

agar deformasi yang terjadi akibat gaya horizontal tidak melampaui ketentuan yang 

disyaratkan (‘P-∆Effect’) (Juwana, 2005).  

Inovasi dalam perencanaan sistem penahan gaya lateral untuk bangunan 

tingkat tinggi terus berkembang. Pengaku gaya lateral yang lazim digunakan adalah 

portal penahan momen, dinding geser atau rangka pengaku (bracing) (Juwana, 

2005). 

2.1.3.1 Dinding Geser 

Dinding geser adalah unsur pengaku vertikal yang dirancang untuk 

menahan gaya lateral atau gempa yang bekerja pada bangunan (Schueller, 2001). 

Berdasarkan letak dan fungsinya, dinding geser dapat diklasifikasikan dalam 3 jenis 

yaitu (Wae, 2013): 

a. Bearing walls adalah dinding geser yang mendukung sebagian besar beban 

gravitasi. Tembok-tembok ini juga menggunakan dinding partisi antar 

apartemen yang berdekatan. 

b. Frame walls adalah dinding geser yang menahan beban lateral, dimana beban 

gravitasi berasal dari frame beton bertulang. Tembok-tembok ini dibangun 

diantara baris kolom. 
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c. Core walls adalah dinding geser yang terletak dikawasan ini pusat memiliki 

fungsi ganda dan dianggap menjadi pilihan paling ekonomis. 

Dalam merencanakan dinding geser, perlu diperhatikan bahwa dinding 

geser yang berfungsi untuk menahan gaya lateral yang besar akibat beban gempa 

tidak boleh runtuh akibat gaya lateral, karena apabila dinding geser runtuh akibat 

gaya lateral maka keseluruhan struktur bangunan akan runtuh karena tidak ada 

elemen struktur yang mampu menahan gaya lateral. Oleh karena itu, dinding geser 

harus didesain untuk amapu menahan gaya lateral yang mungkin terjadi akibat 

beban gempa, dimana berdasarkan SNI 03-2847-2013 pasal 14.5.3.1, tebal 

minimum dinding geser (td) tidak boleh kurang dari 100mm. 

Keruntuhan pada dinding geser disebabkan oleh momen lentur karena 

terjadinya sendi plastis pada kaki dinding. Semakin tinggi suatu gedung, simpangan 

horizontal yang terjadi akibat gaya lateral akan semakin besar untuk itu sering 

digunakan dinding geser pada struktur bangunan tinggi untuk memperkaku struktur 

sehingga simpangan yang terjadi dapat berkurang. Dinding geser juga berfungsi 

untuk mereduksi momen yang diterima struktur rangka sehingga dimensi struktur 

rangka dapat dibuat seefisien mungkin pada struktur bangunan tinggi akibat gaya 

lateral. 

Gaya lateral yang terjadi pada suatu gedung, baik diakibatkan oleh angin 

maupun gempa akan disebar melalui struktur lantai yang berfungsi sebagai 

diafagma horizontal yang kemudian akan ditahan oleh dinding geser karena 

memiliki kekuatan yang besar untuk menahan gaya lateral (Schueller, 2001).  

Pada analisis 3 dimensi struktur, dengan adanya pemasangan dinding geser 

akan menambah kekauan torsi struktur. Pemasangan dinding geser yang simetris 
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dan jauh dari pusat massa (berada di sepanjang keliling) dapat menghindari 

terjadinya mode rotasi pada mode-mode awal struktur yang berbahaya bagi 

keamanan dan kenyamanan pengguna gedung (Krisnahardi, 2010). 

2.1.3.2 Sistem Outrigger 

Seiring perkembangan zaman banyak sistem dan metode perencanaan 

sistem penahan gaya lateral yang dapat digunakan untuk bangunan tingkat tinggi 

salah satunya adalah sistem outrigger. Ketika outrigger menjadi salah satu bagian 

dari struktur yang bersatu dengan bangunan tingkat tinggi dalam dua puluh lima 

tahun terakhir, outrigger ternyata mempunyai sejarah dalam pemakaiannya sehari-

hari sebagai salah satu unsur struktural. Salah satu pemakaian sistem outrigger 

adalah pada kapal layar yang besar. Kapal layar besar pada masa lalu maupun masa 

kini didapati telah menggunakan sistem outrigger untuk menahan tekanan angin 

yang bekerja pada layar kapal. Caranya adalah dengan menyesuaikan dengan 

tonggak layar yang tinggi dan ramping pada kapal sebaik mungkin (Angerik, 2009). 

Dalam bangunan tingkat tinggi, core wall dapat diidentikan dengan tonggak 

layar dari kapal dan outrigger berperan sebagai alat untuk menggelar layar 

(spreader), sedangkan kolom terluar dari bangunan berperan seperti tali ataupun 

penyokong layar pada kapal (stay ataupun shroud) (Angerik, 2009). 

a. Perilaku Sistem Outrigger  

Konsep dari pemakaian outrigger telah tersebar luas dewasa ini, apalagi 

didalam perencanaan bangunan tingkat tinggi. Penggunaan outrigger pada 

bangunan tinggi di luar negeri pada negara maju sudah sangat berkembang. 

Didalam konsep ini, outrigger telah berfungsi sebagai penahan beban lateral yang 

menghubungkan core dengan kolom yang terletak pada bagian terluar bangunan 
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seperti pada gambar 1.1. Core yang dimaksud dapat berupa shear wall maupun 

braced frame sesuai perencanaan (Nair, 1998).  

Sistem outrigger dapat berupa baja maupun beton. Outrigger baja yang 

paling banyak digunakan pada bangunan tingkat tinggi. Untuk beberapa alasan 

seperti biaya, ketersediaan dan pertimbangan pengerjaan, beberapa bangunan tinggi 

menggunakan outrigger beton. Dalam keadaan tersebut outrigger beton menjadi 

pertimbangan utama. Secara teori, terhadap beban angin sistem outrigger harus 

kaku dan elastis. Pada peristiwa gempa yang besar (periode ulang 475 tahun), 

sistem harus bisa menghilangkan energi dan mempertahankannya sebagai sistem 

lateral untuk melindungi bangunan dari keruntuhan. Namun seperti yang diketahui 

sistem outrigger beton sangat brittle. Sistem outrigger teredam adalah robustness 

karena berfungsi untuk situasi angin dan gempa yang sering terjadi. Namun, 

kekakuan outrigger banyak berkurang karena peredam. Dalam kasus dimana sistem 

outrigger harus kaku terhadap gravitasi maupun lateral tanpa redaman tambahan, 

sistem outrigger teredam mungkin merupakan sistem yang sesuai.   

Ketika beban bekerja pada suatu struktur, baik beban angin maupun beban 

gempa, maka kerusakan struktur dapat diminimalkan. Kerusakan bangunan akibat 

beban lateral secara konvensional dapat dicegah dengan memperkuat dan 

memperkaku struktur bangunan terhadap gaya lateral yang bekerja pada struktur 

tersebut. Kerusakan secara non struktural umunya disebabkan karena adanya story 

drift (perbedaan simpangan antar tingkat). Usaha untuk memperkecil story drift 

dilakukan dengan memperkaku bangunan dalam arah lateral dengan outrigger. 

Dampak dari penggunaan outrigger dapat dilihat pada gambar 2.4. Pada gambar 
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tersebut, di titik dimana outrigger diaplikasikan akan terjadi pengurangan 

simpangan yang diakibatkan beban gempa.  

 

Gambar 2. 4 Efek Penggunaan Outrigger pada Bangunan Tinggi 

(Sumber: World Conference on Engineering Earthquake, 2008) 

Sistem outrigger yang digunakan pada bangunan tingkat tinggi tidak 

dipasang pada setiap lantai bangunan. Pemasangan outrigger disesuaikan dengan 

kebutuhan dan perencanaan dari bangunan. Umumnya outrigger pada satu lantai 

atau lebih pada bangunan. Gambar 2.5 merupakan sebuah bangunan tingkat tinggi 

yang menggunakan outrigger truss sebagai penahan gaya lateral. Bangunan 

tersebut menggunakan dua set outrigger dimana satu set outrigger melewati tiga 

lantai. 

 

Gambar 2. 5 Outrigger Pada Bangunan Tingkat Tinggi 

(Sumber: Nair, 1998) 
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Cara kolom terluar untuk menahan bagian dari perputaran momen yang 

dihasilkan oleh beban angin maupun beban lainnya pada bangunan di gambarkan 

pada gambar 2.6. Outrigger truss yang terhubung ke core wall dan kolom di luar 

core, meregangkan kembali perputaran pada core dan mengkonversi bagian dari 

momen pada core menjadi pasangan gaya vertikal pada kolom. Pemendekan dan 

perpanjangan dari kolom serta deformasi dari outrigger dapat menyebabkan 

beberapa perputaran pada core. Dalam perencanaan umum, perputaran terhitung 

kecil sehingga core membalikkannya ke arah bawah outrigger truss (Nair, 1998). 

 

Gambar 2. 6 Transfer Gaya dalam Sistem Outrigger Truss Yang 

Konvensional 

(Sumber: Nair, 1998) 

Dalam konsep penggunaan outrigger truss yang konvensional, outrigger 

truss terhubung secara langsung dengan core dan kolom terluar dari bangunan yang 

mengkonversi momen pada core menjadi pasangan gaya vertikal pada kolom. 

Dalam perencanaan dan aplikasi di lapangan, outrigger truss tidak hanya bisa 

direncanakan secara independen. Untuk merencanakan suatu bangunan tingkat 

tinggi yang menggunkan outrigger truss dapat juga dikombinasikan dengan sistem 

struktural lain yang dikenal dengan belt truss (Nair, 1998). 
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Belt truss adalah struktur rangka batang yang ditempatkan pada kolom-

kolom eksterior dan mengelilingi gedung di sebelah luar. Nair (1998) 

memperkenalkan belt truss dengan sebutan virtual outrigger karena 

penempatannya yang tidak berada ditengah denah bangunan tetapi tetap mampu 

berfungsi sebagai outrigger. Penempatan belt truss pada bangunan tinggi seperti 

pada gambar 2.7. Sistem virtual outrigger mengeliminasi hubungan langsung 

antara dinding geser dengan kolom-kolom luar yang dilakukan oleh balok-balok 

outrigger. Dasar pemikiran utama dari sistem ini yaitu penggunaan lantai diafragma 

yang mempunyai kekakuan yang besar pada bidangnya (in-plane stiffness) untuk 

mentransfer momen guling (overturning moment) yang dialami core akibat gaya 

lateral menjadi gaya kopel horizontal dari dinding ke struktur rangka batang. 

Selanjutnya belt truss akan menkonversi gaya kopel horizontal pada diafragma 

lantai menjadi gaya kopel vertikal pada kolom-kolom eksterior (Nair, 1998).  

 

Gambar 2. 7 Bangunan Tingkat Tinggi Dengan Belt Truss 
(Sumber: Nair, 1998) 
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Gambar 2. 8 (a) Transfer Overturning Moment dari Core ke Diafragma 

Lantai (b) Transfer Gaya dari Diafragma Lantai ke Kolom Eksterior 
(Sumber: Nair, 1998) 

 

 

b. Sistem Interaksi Dinding Geser-Rangka Dengan Belt Truss Kaku  

Rangka diperkaku atau sistem bangunan rangka dan dinding geser menjadi 

tidak efisien lagi diatas ketinggian 40 lantai karena banyak sekali diperlukan bahan 

untuk membuat pengaku yang cukup kaku dan kuat. Efisiensi struktur bangunan 

akan meningkat sebesar 30% dengan menggunakan rangka sabuk atau belt truss 

horizontal untuk mengikat rangka ke inti.  

Rangka sabuk diikat secara kaku ke inti dan dihubungkan dengan kolom 

eksterior. Apabila inti geser melentur, maka belt trus berlaku sebagai lengan yang 

menyalurkan tegangan-tegangan aksial langsung ke kolom luar. Selanjutnya 

kolom-kolom ini berlaku sebagai strut untuk untuk melawan lendutan dari inti. 

Artinya, inti mengumpulkan gaya geser horizontal dan rangka sabuk meneruskan 

gaya geser vertikal dari inti ke rangka fasade. Dengan demikian, bangunan akan 

berlaku sebagai suatu kesatuan, serupa dengan tabung kantilever. 
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Reaksi bangunan rangka inti dengan rangka sabuk terhadap pembebanan 

lateral diberikan pada gambar 2.9. Apabila rangka disendi ke inti suatu struktur 

(gambar 2.9a), maka inti akan berlaku sebagai kantilever dan bagian atasnya akan 

bebas berputar. Rangka ini hampir tidak melawan gaya rotasi. Apabila rangka diikat 

ke inti menggunakan belt truss (gambar 2.9b), maka rotasi di bagian atas sistem ini 

akan ditiadakan karena kolom terluar akan mengikat belt truss ke bawah dan tidak 

akan ada momen lentur pada kolom. Kekakuan parsial yang diberikan di bagian 

atas sistem ini tercermin pada diagram momenya. Sistem ini tidak lagi berlaku 

sebagai kantilever murni karena bagian atasnya terikat semikian pula bagian 

bawahnya. Lendutan yang terjadi berupa kurva S datar dengan momen nol pada 

titik infleksi. Momen lentur di bagian dasar tidak sebesar pada gambar 2.9a. 

 

Gambar 2. 9 Reaksi Rangka Inti dengan Belt Truss 
(Schueller, 2001) 

c. Kelebihan Sistem Outrigger 

Untuk kebanyakan bangunan tingkat tinggi secara umum, jawaban dari 

permasalahan pada struktur core dan sistem tubular adalah daya kerja dari satu atau 

lebih dari lantai yang dipasang outrigger. Outrigger menghubungkan core pada 

bangunan dengan kolom terluar pada bangunan dengan sistem truss maupun 

elemen dinding. Sistem outrigger dapat dibentuk dengan kombinasi baja, beton, 
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maupun struktur komposit. Ketika outrigger telah dipasang efektif, maka dapat 

memberikan keuntungan secara struktural dan fungsional bagi kesuluruhan 

perencanaan bangunan, diantaranya (Angerik, 2009): 

1. Momen yang berputar pada core dan peningkatan deformasi yang terjadi 

dapat dikurangi melalui momen yang berputar berlawanan arah yang 

bekerja pada core pada masing-masing persimpangan outrigger. Momen ini 

ditimbulkan dari pasangan gaya pada kolom terluar yang terhubung dengan 

outrigger. 

2. Pengurangan yang signifikan dan kemungkinan hilangnya gaya ke atas dan 

gaya regang melalui kolom dan pondasi. 

3. Penempatan jarak kolom terluar tidak didasarkan pada pertimbangan 

struktural saja dan dapat dengan mudah dikaitkan dengan pertimbangan 

estetika dan fungsional. 

4. Framing terluar dapat berupa balok biasa yang sederhana dan framing 

kolom tanpa harus membutuhkan sambungan frame yang kaku, 

mengakibatkan perencanaan lebih ekonomis. 

d. Kelemahan Sistem Outrigger 

Setiap sistem perencanaan tentunya mempunyai memiliki kelebihan dan 

kelamahannya masing-masing. Sistem outrigger yang mempunyai beberapa 

kelebihan juga mempunyai kelemahan. Beberapa kelemahan yang akan timbul 

akibat penggunaan outrigger yaitu (Nair, 1998): 

1. Ruang yang termakan akibat pemasangan outrigger (terutama bagian yang 

diagonal), memakan tempat yang cukup banyak pada lantai dimana 

outrigger dipasang. Bahkan pada lantai penyimpanan mesin dan 
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perlengkapan, keberadaan outrigger merupakan masalah yang paling utama 

karena tidak tertutup kemungkinan bahwa satu lantai yang menggunakan 

outrigger tidak dapat difungsikan sebagimana mestinya. 

2. Masalah arsitektural dan fungsional dari bangunan tersebut yang dapat 

menjadi pertimbangan karena pengaruh dari pemasangan outrigger yang 

terhubung dengan core wall pada bangian tengah bangunan. 

3. Cara untuk menghubungkan outrigger dengan core wall dapat menjadi 

suatu hal yang sangat rumit. Tingkat kesulitan akan semakin tinggi apabila 

sistem core yang direncanakan adalah shear wall dari beton. 

4. Dalam beberapa hal, core dan outrigger tidak akan memendek secara 

bersamaan karena pengaruh gaya gravitasi. Outrigger haruslah sangat kaku 

agar dapat berfungsi dengan efektif dan maksimal. Outrigger dapat 

mengalami tegangan yang cukup signifikan ketika mencoba untuk 

mengontrol perbedaan pemendekan antara batang-batang outrigger. 

Ketelitian yang tinggi dan biaya tambahan juga diperlukan dalam 

permasalahan ini. Selain itu, penyelesaian beberapa sambungan harus 

ditunda hingga bangunan hampir mencapai puncak penyelesaian 

pembangunannya karena lantai bangunan yang menggunakan outrigger 

harus sangat kaku. Semua usaha ini dilakukan untuk mengurangi masalah 

yang terjadi akibat perbedaan pemendekan. 

2.1.4 Teori Gempa 

Gempa bumi adalah suatu peristiwa pelepasan energi gelombang seismic 

yang terjadi secara tiba-tiba (Hartuti, 2009). Pelepasan energi ini diakibatkan 

karena adanya deformasi lempeng tektonik yang terjadi pada kerak bumi.  
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Menurut proses terjadinya, gempa bumi dapat diklasifikasi menjadi lima 

(Hartuti, 2009). Berikut ini klasifikasi gempa bumi tersebut. 

a. Gempa tektonik, yaitu gempa yang terjadi akibat adanya tumbukan lempeng-

lempeng di lapisan litosfer kulit bumi oleh tenaga tektonik. 

b. Gempa vulkanik, yaitu gempa yang terjadi akibat aktivitas gunung berapi. Oleh 

karena itu gempa ini hanya dapat dirasakan di sekitar gunung berapi saat akan 

meletus, saat meletus, dan setelah terjadi letusan. 

c. Gempa runtuhan atau longsoran, yaitu gempa yang terjadi karena 

adanyaruntuhan tanah atau batuan. Lereng gunung atau pantai yang curam 

memiliki energi potensial yang besar untuk runtuh. 

d. Gempa jatuhan, yaitu gempa yang terjadi akibat adanya benda langit yang jatuh 

ke bumi, misalnya meteor. 

e. Gempa buatan, yaitu gempa yang memang sengaja dibuat oleh manusia. Salah 

satu contohnya suatu percobaan peledakan nuklir bawah tanah atau laut dapat 

menimbulkan getara bumi yang dapat tercatat oleh seismograf. 

Gempa bumi tektonik adalah jenis gempa yang paling sering dirasakan, 

terutama di Indonesia. Hal ini terjadi karena dari sebelah barat hingga timur 

Indonesia dibatasi oleh lempeng yang berbeda. Indonesia merupakan daerah 

pertemuan 3 lempeng tektonik besar yaitu lempeng Indo-Australia, Eurasia dan 

lempeng Pasifik. Lempeng Indo-Australia bertabrakan dengan lempeng Eurasia di 

lepas pantai Sumatera, Jawa dan Nusa Tenggara. Lempeng Eurasia dan lempeng 

Pasifik di utara Irian dari Maluku Utara. Beberapa sesar aktif yang terkenal di 

Indonesia adalah sesar Sumatera, sesar Cimandari di Jawa Barat, sesar Palu-Koro 
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di Sulawesi, sesar naik Flores, sesar naik Wetar, dan sesar geser Sorong (Bahri, 

2016).   

 

Gambar 2. 10 Lempeng Tektonik di Indonesia 

(Sumber: Bahri 2016) 

Kondisi lempeng tektonik Indonesia seperti gambar 2.10 menyebabkan 

kota-kota Indonesia menjadi daerah rawan terjadi gempa bumi. Kota-kota yang 

rawan gempa bumi diantaranya Nangroe Aceh Darussalam, Sumatera Utara-

Simeuleu, Sumatera Barat-Jambi, Bengkulu, Lampung, Banten-Pandeglang, Jawa 

Barat-Bentar Kawung, Daerah Istimewa Yogyakarta, Lasem, Jawa Timur-Bali, 

Nusa Tenggara Barat, Nusa Tenggara Timur, Kepulauan Aru, Sulawesi Selatan, 

Sulawesi Tenggara, Sulawesi Tengah, Sulawesi Utara, Sangihe Talaud, Maluku 

Utara, Maluku Selatan, Kepulauan Burung-Papua Utara, Jayapura, Nabire, 

Wamena, Kalimantan Timur (Bahri, 2016).  
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2.1.4.1 Perilaku Struktur Akibat Beban Gempa 

Pondasi merupakan titik singgung antara bangunan dengan tanah, maka 

gerak seismik akan bekerja pada bangunan melalui pondasi.  Gerak seismik akan 

ditahan oleh massa bangunan dengan membangun gaya inersia pada seluruh 

struktur. Besar gaya inersia (F) bergantung pada massa bangunan (m), percepatan 

permukaan (a) dan sifat struktur. Apabila bangunan dan pondasinya kaku, maka 

percepatannya akan sama dengan permukaan, yaitu menurut rumus Newton 

(Schueller, 2001): 

𝐹 = 𝑚. 𝑎        (2.1) 

Untuk struktur yang hanya sedikit berubah bentuk (deformasi), artinya 

menyerap sebagian energi, besar gayanya akan kurang dari massa dikali 

percepatannya (F<m.a) seperti gambar 2.11b. Akan tetapi, struktur yang sangat 

fleksibel yang mempunyai waktu getar alamiah yang mendekati waktu getar 

gelombang permukaan, dapat mengalami gaya yang jauh lebih besar yang 

ditimbulkan oleh gerak permukaan yang berulang-ulang (F>m.a) seperti gambar 

2.11c (Schueller, 2001). 

 

Gambar 2. 11 Perilaku Struktur terhadap Beban Lateral 

(Sumber: Schueller, 1989) 
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Sebuah struktur yang mendapat beban gempa akan memberikan respon 

terhadap beban gempa tersebut. Respon yang diberikan struktur bergantung pada 

kekakuan struktur sehingga pergerakan akibat beban gempa dapat dibatasi. 

Kekakuan struktur dapat dilihat dari respon struktur berupa simpangan, gaya geser 

dasar dan periode. Respon struktur pada bangunan yang mendapat beban gempa 

terlihat dari adanya simpangan antar tingkat pada bangunan. Simpangan terbagi 

menjadi dua jenis yaitu displacement dan drift. Displacement merupakan 

simpangan suatu lantai yang diukur dari dasar lantai sedangkan drift adalah 

simpangan lantai yang diukur dari dasar lantai dibawahnya.  

1. Simpangan antar lantai  

Dalam SNI 03 1726 2012 penentuan simpangan antar lantai tingkat desain 

(∆) harus dihitung sebagai perbedaan defleksi pada pusar massa di tingkat teratas 

dan terbawah yang ditinjau. Apabila pusat massa tidak terletak segaris dalam arah 

vertikal, diizinkan untuk menghitung defleksi di dasar tingkat berdasarkan proyeksi 

vertikal dan pusat massa di tingkat atasnya. Defleksi pusat massa di tingkat x di 

pusat massa harus ditentukan sesuai dengan persamaan berikut: 

𝛿𝑥 =
𝐶𝑑𝛿𝑥𝑒

𝐼𝑒
 

Keterangan: 

𝐶𝑑 = faktor pembesaran defleksi 

𝛿𝑥𝑒 = defleksi pada lokasi yang disyaratkan 

𝐼𝑒 = faktor keutamaan 

Sesuai SNI 03 1726 2012, nilai simpangan antar tingkat desain (∆) memiliki 

syarat nilainya tidak boleh melebihi simpangan antar lantai tingkat ijin (∆a) seperti 

didapatkan dari tabel 2.1 untuk semua tingkat. 
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Tabel 2. 2 Simpangan Antar Lantai Ijin (∆a
a.b) 

Struktur 
Kategori Resiko 

I atau II III IV 

Struktur, selain dari struktur dinding geser batu 

bata, 4 tingkat atau kurang dengan dinding 

interior, partisi, langit-langit dan sistem 

dinding eksterior yang telah didesain untuk 

mengakomodasi simpangan antar lantai 

tingkat. 

0,025hsx
 0,020 hsx 0,015 hsx 

Struktur dinding geser kantilever batu bata 0,010 hsx 0,010 hsx 0,010 hsx 

Struktur dinding geser batu bata lainnya 0,007 hsx 0,007 hsx 0,007 hsx 

Semua struktur lainnya 0,020 hsx 0,015 hsx 0,010 hsx 
Catatan: hsx = tinggi tingkat di bawah tingkat x 

(Sumber: SNI 1726 2012) 

Dalam SNI 1726 2012 kategori resiko bangunan terbagi menjadi empat 

kategori berdasarkan jenis pemanfaatan gedung dan non gedung. Semakin tinggi 

kategori resiko maka semakin besar kemungkinan bangunan mengalami kerusakan 

akibat gempa.  

Tabel 2. 3 Kategori Resiko Bangunan Gedung dan Non Gedung untuk Beban 

Gempa 

Jenis pemanfaatan Kategori 

resiko 

Gedung dan non gedung yang memiliki resiko rendah terhadap jiwa 

manusia pada saat terjadi kegagalan, termasuk, tetapi tidak dibatasi 

untuk, antara lain: 

- Fasilitas pertanian, perkebunaan, peternakan, dan perikanan 

- Fasilitas sementara 

- Gedung penyimpanan 

- Rumah jaga dan struktur kecil lainnya 

I 

Semua gedung dan struktur kecil lain, kecuali yang termasuk dalam 

kategori resiko I, III, IV, termasuk, tapi tidak dibatasi untuk: 

- Perumahan 

- Rumah toko dan rumah kantor 

- Pasar 

- Gedung perkantoran 

- Gedung apartemen/ rumah susun 

- Pusat pembelanjaan/ mall 

- Bangunan industry 

- Fasilitas manufaktur 

- Pabrik 

II 

Gedung dan non gedung yang memiliki resiko tinggi terhadap jiwa 

manusia pada saat kegalalan, termasuk, tapi tidak dibatasi untuk: 

III 
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- Bioskop 

- Gedung pertemuan 

- Stadion 

- Fasilitasa kesehatan yang tidk memiliki unit bedah dan unit 

gawat darurat 

- Fasilitas penitipan anak 

- Penjara 

- Bangunan untuk orang jompo 

Gedung dan non gedung, tidak termasuk tidak kedalam kategori 

resiko IV, yang emiliki potesi untuk menyebabkan dampak ekonomi 

yang besar dan/atau gangguan massalterhadap kehidupan masyarakat 

sehari-hari bila terjadi kegagalan, termasuk, tapi tidak dibatasi untuk: 

- Pusat pembangkit listrik biasa 

- Fasilitas penanganan air 

- Fasiliats penanganan limbah 

- Pusat telekomunikasi 

Gedung dan non gedung yang tidak termasuk dalam kategori resiko 

IV, (termasuk, tetapi tidak dibatasi untuk fasilitas manufaktur, proses, 

penanganan, penyimpanan, penggunaan atau tempat pembuangan 

bahan bakar berbahaya, bahan kimia berbahaya, limbah berbahaya, 

atau bahan yang mudah meledak) yang mengandung bahan neracun 

atau peledakdimana jumlah kandungan bahannya melebihi nilai batas 

yang disyaratkan oleh instansi yang berwenang dan cukup 

menimbulkan bahaya bagi masyarakat jika terjadi kebocoran. 

Gedung dan non gedung yang ditunjukkan sebagai fasilitas yang 

penting, termasuk, tetapi tidak dibatasi untuk: 

- Bangunan-banguna monumental 

- Gedung sekolah dan fasilitas Pendidikan 

- Rumah sakit dan fasilitas lainnya yang memeiliki fasilitas 

bedah dan unit gawat darurat 

- Fasilitas pemadam kebakaran, ambulans, dan kantor polisi, 

serta garasi kendaraan darurat  

- Tempat perlindungan terhadap gempa bumi, angina badai, dan 

tempat perlindungan darurat lainnya 

- Fasilitas kesiapan darurat, komunikasi, pusat operasi dan 

fasilitas lainnya untuk tanggap darurat 

- Struktur tambahan (termasuk menara telekomunikasi, tangka 

penyimpanan bahan bakar, Menara pendingin, struktur stasiun 

listrik, tengki air pemadam kebakaran atau struktur rumah atau 

struktur pendukung air atau material atau peralatan pemadam 

kebakaran) yang disyaratkan untuk beroperasi pada saat 

keadaan darurat 

Gedung dan non gedung yang dibutuhkan untuk mempertahankan 

fungsi struktur bangunan lain yang masuk kedalam kategori resiko IV. 

IV 

(Sumber: SNI 1726 2012) 
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Tabel 2. 4 Faktor Keutamaan Gempa 

Kategori resiko Faktor keutamaan gempa, Ie 

I atau II 1,0 

III 1,25 

IV 1,50 
(Sumber: SNI 1726 2012) 

2. Gaya Geser Dasar (Base Shear) 

Salah satu faktor yang mempengaruhi besarnya simpangan antar lantai 

adalah gaya geser dasar (base shear). Gaya geser dasar adalah pengganti atau 

penyederhanaan dari getaran yang gempa bumi yang bekerja pada dasar bangunan 

dan selanjutnya digunakan sebagai gaya gempa rencana yang harus ditinjau dalam 

perencanaan dan evaluasi struktur bangunan gedung. Gaya geser dasar akan 

didistribusikan secara vertikal sepanjang tinggi sturuktur sebagai gaya horizontal 

tingkat yang bekerja pada masing-masing tingkat bangunan. Dengan 

menjumlahkan gaya horizontal pada tingkat-tingkat yang ditinjau dapat diketahui 

gaya geser tingkat yaitu gaya geser yang terjadi pada dasar tingkat yang ditinjau. 

Akibat dari gaya yang terjadi pada tingkat-tingkat tersebut maka akan 

mengakibatkan terjadinya perpindahan dan simpangan pada tingkat-tingkat 

tersebut (Cornelius, 2014). Gaya geser dasar (V) pada dasar suatu bangunan dapat 

dinyatakan sebagai berikut: 

𝑉 = 𝐶𝑠. 𝑊 =
𝑆𝐷𝑆. 𝐼𝑒

𝑅
. 𝑊 

dengan,  

SDS = Spektrum respon percepatan desain (g) 

Ie = Faktor keutamaan gempa 

R = Koefisien modifikasi respon 

W = Beban efektif Seismik (kN) 
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3. Perioda Getar Alami 

Perioda getar alami adalah waktu yang diperlukan getaran untuk melakukan 

satu siklus bolak-balik lengkap. Besarnya periode yang terjadi pada struktur 

tergantung pada massa struktur dan kekakuan kolom. Jika kolom pada struktur 

mempunyai kekuan yang kecil, maka gaya pemulihan yang diperlukan untuk 

mengembalikan struktur dari keadaan terdefleksi ke posisi semula juga relatif kecil. 

Dengan demikian puncak dari struktur akan bergerak bolak-balik secara relatif 

lebih lambat sampai getaran berhenti sehingga struktur dengan ekakauan kolom 

yang kecil mempunyai waktu getar alami yang panjang. Sebaliknya struktur dengan 

kolom yang kaku, akan memberikan gaya pemulihan yang besar sehingga getaran 

yang terjadi akan berhenti dalam waktu yang relatif singkat sehingga mempunyai 

waktu getar alami yang pendek. 

Berdasarkan SNI 1726-2012, perioda fundamental atau periode getar alami 

struktur (T) tidak boleh melebihi hasil koefisin untuk Batasan atas pada perioda 

yang dihitung (Cu) dari tabel 2.4 dan perioda fundamental pendekatan (Ta). 

Diijinkan secara langsung menggunakan perioda bangunan pendekatan (Ta) untuk 

menentukan perioda fundamental struktur (T) sebagai berikut: 

𝑇𝑎 = 𝐶𝑡. ℎ𝑛
𝑥 

Dengan hn adalah ketinggian struktur (m) di atas dasar sampai tingkat 

tertinggi struktur, dan koefisien Ct dan x ditentukan dari tabel 2.5. 

Tabel 2. 5 Koefisien Untuk Batas Atas Pada Perioda Yang Dihitung 

Parameter percepatan respon spektral 

desain pada 1 detik, SD1 

Koefisien Cu 

0,4 1,4 

0,3 1,4 

0,2 1,5 

0,15 1,6 

0,1 1,7 
Sumber: SNI 1726-2012  
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Tabel 2. 6 Nilai Parameter Perioda Pendekatan Ct dan x 

Tipe Struktur Ct x 

Sistem rangka pemikul momen dimana rangka memikul 100 persen gaya gempa 

yang disyaratkan dan tidak dilingkupi atau dihubungkan dengan komponen yang 

lebih kaku dan akan mencegah rangka dari deflrksi jika dikenal gaya gempa: 

Rangka baja pemikul momen 0,0724 0,8 

Rangka beton pemikul momen 0,0466 0,9 

Rangka naja dengan bresing eksentris 0,0731 0,75 

Rangka baja dengan bresing terkekang terhadap tekuk 0,0731 0,75 

Semua sistem struktur lainnya 0,0488 0,75 
Sumber: SNI 1726-2012 

2.1.4.2 Kategorisasi Desain Seismik 

Dalam SNI 1726 2012 kategori desian seismik terbagi menjadi 6 yaitu, A, 

B, C, D, E, dan F berdasarkan kategori resiko gedung dan non gedung dan respon 

spektral. Struktur dengan kategori resiko I, II atau III yang berlokasi dimana 

parameter respons spectral percepatan terpetakan pada perioda 1 detik, S1, lebih 

besar dari atau sama dengan 0,75 harus ditetapkan sebagai struktur dengan kategori 

desain seismik E. Struktur yang berkategori resiko IV yang berlokasi dimana 

parameter respons spectral percepatan terpetakan pada perioda 1 detik, S1, lebih 

besar dari atau sama dengan 0,75, harus ditetapkan sebagai struktur dengan kategori 

desain seismik F. semua struktur lainnya harus ditetapkan kategori desain 

seismiknya berdasarkan kategori resiko dan parameter respon spektral percepatan 

desainnya, SDS pada tabel 2.7 dan SD1 pada tabel 2.8. 

Tabel 2.7 Kategori Desain Seismik Berdasarkan Parameter Respon 

Percepatan pada Perioda Pendek 

Nilai SDS 
Kategori Resiko 

I atau II atau III IV 

SDS < 0,167 A A 

0,167 ≤ SDS < 0,33 B C 

0,33 ≤ SDS < 0,5 C D 

0,5 ≤ SDS D D 
(Sumber: SNI 1726 2012) 
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Tabel 2.8 Kategori Desain Seismik Berdasarkan Parameter Respon 

Percepatan pada Perioda 1 Detik 

Nilai SD1 
Kategori Resiko 

I atau II atau III IV 

SD1 < 0,067 A A 

0,067 ≤ SD1 < 0,133 B C 

0,133 ≤ SD1 < 0,20 C D 

0,20 ≤ SD1 D D 
(Sumber: SNI 1726 2012) 

2.1.4.3 Metode Analisa Respon Spektrum  

Dalam SNI 1726 2012 prosedur analisis yang boleh digunakan untuk 

menganalisis beban gempa dijelaskan dengan tabel 2.9. 

Tabel 2. 9  Prosedur Analisis yang boleh digunakan 

Kategori 

desain 

seismik 

Karakteristik struktur 

Analisis 

gaya 

lateral 

ekivalen  

Analisis 

spektrum 

respon 

ragam  

Analisis 

riwayat 

respons 

seismik  

B,C Bangunan dengan kategori resiko I 

atau II dari konstruksi rangka 

ringan dengan ketinggian tidak 

melebihi 3 tingkat 

I I I 

Bangunan dengan kategori resiko I 

atau II, dengan ketinggian tidak 

melebihi 2 tingkat 

I I I 

Semua struktur lainnya I I I 

D, E, F Bangunan dengan kategori resiko I 

atau II dari konstruksi rangka 

ringan dengan ketinggian tidak 

melebihi 3 tingkat 

I I I 

Bangunan dengan kategori resiko I 

atau II, dengan ketinggian tidak 

melebihi 2 tingkat 

I I I 

Struktur beraturan dengan T< 3,5Ts 

dan semua struktur dari konstruksi 

rangka ringan 

I I I 

Struktur tidak beraturan dengan T< 

3,5 Ts dan mempunyai hanya 

ketidak beraturan horizontal tipe 2, 

3, 4, atau 5 dari tabel 10 atau 

ketidakberaturan vertikal tipe 4, 5a, 

atau 5b dari tabel 11 

I I I 

Semua struktur lainnya TI I I 
CATATAN: I: Dijinkan, TI: Tidak Diijinkan 
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(Sumber: SNI 1726 2012) 

Salah satu metode yang dapat digunakan untuk menganalisis beban gempa 

pada suatu bangunan adalah metode respon spektrum. Menurut SNI 1726 2012, 

respon spectrum adalah suatu diagram hubungan antara percepatan respon 

maksimum suatu sistem satu derajat kebebasan akibat gempa tertentu, sebagai 

fungsi dari faktor redaman dan waktu getar alami. 

Berdasarkan SNI 1726 2012 tahapan mendesain respon spektrum dengan 

menghitung persamaan-persamaan sesuai periode. Dari parameter Ss yaitu 

parameter percepatan batuan dasar pada periode pendek dan parameter S1 yaitu 

parameter percepatan batuan dasar pada periode 1 detik didapat parameter respon 

spektrum dengan mengunakan persamaan: 

SMs = FaSs        (2.1) 

SM1 = FvS1        (2.2) 

Nilai parameter Ss ditentukan dengan melihat peta zonasi gempa Indonesia 

percepatan batuan dasar periode pendek pada gambar 2.12 dan nilai parameter S1 

dengan melihat peta zonasi gempa Indonesia percepatan batuan dasar periode 1 

detik pada gambar 2.13. Fa yaitu faktor amplifikasi getaran terkait percepatan pada 

getaran periode pendek dan Fv yaitu faktor amplifikasi getaran terkait percepatan 

getaran periode 1 detik. Nilai Fa ditentukan oleh kelas situs dan nilai Sa sedangkan 

nilai Fv ditentukan oleh kelas situs dan S1. Kelas situs dapat ditentukan dengan 

melihat tabel 2.10. Nilai Fa dapat ditentukan berdasarkan tabel 2.11 dan nilai Fv 

dapat ditentukan berdasarkan tabel 2.12. 
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Gambar 2. 12 Parameter Ss 

(Sumber: SNI 1726 2012) 

 

Gambar 2. 13 Parameter S1 
(Sumber: SNI 1726 2012) 

 

Tabel 2. 10 Kelas Situs 

Kelas situs Vs (m/detik) N atau Nch Su (kPa) 

SA (batuan keras) >1500 N/A N/A 

SB (batuan) 750 – 1500 N/A N/A 

SC (tanah keras, sangat 

padat dan batuan lunak) 

350 – 750 >50 ≥100 

SD (tanah sedang) 175 – 350 15 - 50 50 - 100 

SE (tanah lunak) <175 <15 <50 
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Atau setiap profil tanah yang mengandunglebih 

dari 3m tanah dengan karakteristik sebagai 

berikut: 

1. Indeks plastisitas, PI > 20, 

2. Kadar air, w ≥ 40%, 

3. Kuat geser niralir Su <25 kPa 

SF (tanah khusus yang 

membutuhkan investigasi 

geoteknik spesifik dan 

analisis respons spesifik-

situs yang mengikuti 6.10.1 

Setiap profil lapisan tanah yang memiliki salah 

satu atau lebih dari karakteristik berikut: 

• Rawan dan berpotensi gagal atau runtuh akibat 

beban gempa seperti mudah likuifasi, lempung 

sangat sensitive, tana tersegmentasi lemah 

• Lempung sangat organic dan/atau gambut 

(ketebalan H > 3m) 

• Lempung berplastisitas sangat tinggi 

(ketebalan H > 7,5 m dengan Indeks Plaktisitas 

PI >75) 

• Lapisan lempung lunak/setengah teguh dengan 

ketebalan H > 35 m dengan Su < 50 kPa 
Catatan: N/A = tidak dapat dipakai 

(Sumber: SNI 1726 2012) 

 

Tabel 2. 11 Koefisien situs, Fa 

Kelas 

situs 

Parameter respons spectral percepatan gempa (MCER) terpetakan 

pada periode pendek, T=0,2 detik, Ss 

Ss ≤ 0,25 Ss = 0,5 Ss = 0,75 Ss = 1,0 Ss = ≥ 1,25 

SA 0,8 0,8 0,8 0,8 0,8 

SB 1,0 1,0 1,0 1,0 1,0 

SC 1,2 1,2 1,1 1,0 1,0 

SD 1,6 1,4 1,2 1,1 1,0 

SE 2,5 1,7 1,2 0,9 0,9 

SF SSb 

Catatan:  

a. Untuk nilai-nilai antara Ss dapat dilakukan interpolasi linear 

b. SS= Situs yang memerlukan investigasi geoteknik spesifik dan analisis respons situs-spesifik, 

lihat 6.10.1 

(Sumber: SNI 1726 2012) 

Tabel 2. 12 Koefisien situs, Fv 

Kelas 

situs 

Parameter respons spectral percepatan gempa (MCER) terpetakan 

pada periode 1 detik, Ss 

Ss ≤ 0,1 Ss = 0,2 Ss = 0,3 Ss = 0,4 Ss = 0,5 

SA 0,8 0,8 0,8 0,8 0,8 

SB 1,0 1,0 1,0 1,0 1,0 

SC 1,7 1,6 1,5 1,4 1,3 

SD 2,4 2 1,8 1,6 1,5 
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SE 3,5 3,2 2,8 2,4 2,4 

SF SSb 

Catatan:  

a. Untuk nilai-nilai antara S1 dapat dilakukan interpolasi linear 

b. SS= Situs yang memerlukan investigasi geoteknik spesifik dan analisis respons 

situs-spesifik, lihat 6.10.1 

(Sumber: SNI 1726 2012) 

 

Setelah nilai parameter respon spectrum SMS dan SM1 dihitung selanjutnya 

dapat dilakukan perhitumgan percepatan spectral desain untuk gempa pendek (SDS) 

dan percepatan spectral desain gempa periode 1 detik. Perhitungan tersebut dapat 

dilakukan dengan persamaan berikut: 

𝑆𝐷𝑆 =
2

3
𝑆𝑀𝑆         (2.3) 

𝑆𝐷1 =
2

3
𝑆𝑀1        (2.4) 

Perhitungan percepatan spectral desain untuk gempa digunakan untuk 

menentukan grafik spectrum respons desain. Grafik ini menjelaskan hubungan 

periode dengan percepatan respon spectra seperti pada gambar 2.14. 

 

Gambar 2. 14 Grafik Spektrum Respons Desain 
(Sumber: SNI 1726 2012) 
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Keterangan: 

T = periode getar fundamental struktur.  

𝑇0 = 0,2
𝑆𝐷1

𝑆𝐷𝑆
        (2.5) 

𝑇𝑆 =
𝑆𝐷1

𝑆𝐷𝑆
        (2.6) 

Untuk 𝑇 <  𝑇0, Sa dihitung dengan persamaan: 

𝑆𝑎 = 𝑆𝐷𝑆 (0,4 + 0,6
𝑇

𝑇0
)      (2.7) 

Untuk 𝑇0 ≤ 𝑇 ≤ 𝑇𝑆, Sa dihitung dengan persamaan: 

𝑆𝑎 = 𝑆𝐷𝑆        (2.8) 

Untuk 𝑇 >  𝑇𝑆, Sa dihitung dengan persamaan: 

𝑆𝑎 =
𝑆𝐷1

𝑇
        (2.9) 

Apabila kombinasi respons untuk geser dasar ragam (Vt) lebih kecil 85% dari geser 

dasar hitung (V) menggunakan prosedur static ekivalen, maka gaya harus dikalikan 

dengan 0,85 V/Vt. 

Hal yang perlu diperhatikn untuk metode analisis respon spectrum adalah factor 

skala input pada ETABS. Analisis respon spectrum dilakukan dengan input dari 

grafik spectrum gempa rencana yang nilai ordinatnya dikalikan factor koreksi. 

𝐹𝑆 = 𝑔 (
𝐼

𝑅
)        (2.10) 

Keterangan: 

FS = faktor skala 

g = percepatan gravitasi bumi (9,81m/s2) 

I  = factor keutamaan gempa 

R = koefisien modifikasi respons, lihat tabel 2.10 
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Tabel 2. 13 Faktor Modifikasi Respons 

System Penahan Gaya 

Seismik 
R Cd 

Batasan system struktur dan Batasan 

tinggi struktur, hn (m)e 

Kategori desain seismic 

B C Dd Ed Fe 

Rangka baja pemikul momen 

khusus 
8 5,5 TB TB TB TB TB 

Rangka batang baja pemikul 

momen khusus 
7 5,5 TB TB 48 30 TI 

Rangka baja pemikul momen 

menengah 
4,5 4 TB TB 10 TI TI 

Rangka baja pemikul momen 

biasa 
3,5 3 TB TB TI TI TI 

Rangka beton bertulang 

pemikul momen khusus 
8 5,5 TB TB TB TB TB 

Rangka beton bertulang 

pemikul momen menengah 
5 4,5 TB TB TI TI TI 

Rangka beton bertulang 

pemikul momen biasa 
3 2,5 TB TI TI TI TI 

Rangka baja dan beton 

komposit pemikul momen 

khusus 

8 5,5 TB TB TB TB TB 

Rangka baja dan beton 

komposit pemikul momen 

menengah 

5 4,5 TB TB TI TI TI 

Rangka baja dan beton 

komposit terkekang parsial 

pemikul momen 

6 5,5 48 48 30 TI TI 

Rangka baja dan beton 

komposit pemikul momen 

biasa 

3 2,5 TB TI TI TI TI 

Rangka baja canai dingin 

pemikul momen khusus 

dengan pembautan 

3,5 3,5 10 10 10 10 10 

Keterangan: 

R = Koefisien modifikasi respons 

Cd = Factor pembesar defleksi 

TB = Tidak dibatasi 

TI = Tidak diijinkan 

(Sumber: SNI 1726 2012) 
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2.1.5 Pembebanan Struktur 

Beban merupakan sekelompok gaya yang akan bekerja pada suatu luasan 

struktur. Beban yang akan dipikul oleh suatu struktur harus direncanakan dengan 

benar. Kesalahan dalam perencanaan beban atau penerapan beban pada perhitungan 

akan mengakibatkan kesalahan fatal pada hasil desain bangunan. Beban yang 

umum direncanakan pada struktur yaitu: 

1. Beban Mati 

Menurut SNI 1727 2013, beban mati adalah berat seluruh bahan konstruksi 

bangunan gedung yang terpasang, termasuk dinding, lantai, atap, plafon, tangga, 

dinding partisi tetap, finishing, klading gedung dan komponen arsitektural dan 

structural lainnya serta peralatan layan yang terpasang lain termasuk berat keran. 

Dalam menentukan beban mati untuk perencanaan, harus digunakan berat bahan 

dan konstruksi sebenarnya, dengan ketentuan bahwa jika tidak ada informasi yang 

jelas, nilai yang harus digunakan adalah nilai yang disetujui pihak yang berwenang.  

2. Beban Hidup  

Dalam SNI 1727 2013, beban hidup adalah beban yang diakibatkan oleh 

pengguna dan penghuni bangunan gedung atau struktur lain yang tidak termasuk 

beban konstruksi dan beban lingkungan, seperti beban angin, beban hujan, beban 

gempa, beban bajir, atau beban mati. Beban hidup meliputi manusia, barang-barang 

yang dapat berpindah, mesin-mesin serta peralatan yang tidak terpisahkan dari 

gedungdan dapt diganti selama masa hidup bangunan. Beban hidup yang digunakan 

dalam perencanaan bangunan gedung dan struktur lain harus beban maksimum 

yang diharapkan terjadi akibat penghunian dan penggunaan bangunan gedung kan 
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tetapi tidak boleh kurang dari beban merata minimum yang ditetapkan dalam SNI 

1727 2013. 

3. Beban Gempa 

Beban gempa adalah beban statik ekuivalen yang bekerja pada bangunan 

atau bagian bangunan yang menirukan pengaruh dari gerakan tanah akibat gempa, 

ketika pengaruh gempa pada struktur bangunan ditentukan berdasarkan suatu 

analisis dinamik, maka yang diartikan dengan beban gempa adalah gaya-gaya 

dalam struktur tersebut yang terjadi oleh gerakan tanah akibat gempa. Menurut SNI 

1726 2012, pengaruh pembebanan gempa dalam arah utama yang ditentukan harus 

dianggap efektif 100% dan harus dianggap terjadi bersamaan dengan pengaruh 

pembebenan gempa dalam arah tegak lurus pada arah utama tetapi efektifitasnya 

30%. 

Dalam perencanaan pembebanan struktur umumnya digunakan kombinasi 

pembebanan untuk menghitung beban yang akan ditanggung bangunan. Kombinasi 

pembebanan yang digunakan sesaui dengan SNI 03-2847-2013 tentang Tata Cara 

Perencanaan Struktur Beton untuk Bangunan Gedung, yaitu: 

1. U = 1,4 D 

2. U = 1,2 D + 1,6 L + 0,5 (Lr atau R) 

3. U = 1,2 D + 1,6 (Lr atau R) + (1,0L atau 0,5W) 

4. U = 1,2 D + 1,0 W + 0,5 (Lr atau R) 

5. U = 1,2 D + 1,0 E + 1,0 L 

6. U = 0,9 D + 1,0 W 

7. U = 0,9 D + 1,0 E 

Pengaruh beban gempa (E) harus ditentukan seperti berikut ini: 
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a. Untuk penggunaan dalam kombinasi beban 5 atau kombinasi beban 5 dan 6, E 

harus ditentukan sesuai dengan persamaan berikut: 

𝑬 = 𝑬𝒉 + 𝑬𝒗        (2. 11) 

b. Untuk penggunaan dalam kombinasi beban 7 atau kombinasi beban 8, E harus 

ditentukan sesuai dengan persamaan berikut: 

𝑬 = 𝑬𝒉 − 𝑬𝒗        (2. 12) 

Keteragan: 

E = pengaruh beban gempa 

Eh = pengaruh beban gempa horizontal 

Ev = pengaruh beban gempa vertikal 

Pengaruh beban gempa horizontal (Eh) harus ditentukan sesuai dengan persamaan 

berikut: 

𝑬𝒉 =  𝝆𝑸𝒙        (2. 13) 

Keterangan: 

Q = pengaruh gaya gempa horizontal dari V atau Fp 

Ρ = faktor resudansi 

Pengaruh beban gempa vertikal (Ev) harus ditentukan dengan persamaan berikut: 

𝑬𝒗 = 𝟎, 𝟐 𝑺𝑫𝑺 𝑫       (2. 14) 

Keterangan: 

SDS = parameter percepatan spektrum respon desain pada periode pendek 

D      = beban mati 

Sehingga kombinasi pembebanan akan menjadi seperti berikut: 

1. 1,4 D 

2. 1,2 D + 1,6 D 

3. 1,2 D + 1,0 L ± 0,3(ρ QEx + 0,2SDSD) ± 1,0 (ρ QEy + 0,2SDSD) 

4. 1,2 D + 1,0 L ± 1,0(ρ QEx + 0,2SDSD) ± 0,3 (ρ QEy + 0,2SDSD) 
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5. 0,9 D ± 0,3(ρ QEx - 0,2SDSD) ± 1,0 (ρ QEy - 0,2SDSD) 

6. 0,9 D ± 1,0(ρ QEx - 0,2SDSD) ± 0,3 (ρ QEy - 0,2SDSD) 

2.1.6 Software ETABS 

Untuk mempermudah analisis perencanaan suatu struktur, para perencana 

menggunakan alat bantu berupa software. Extended Three-Dimension Analysis 

Building System (ETABS) merupakan satu dari beberapa software yang umum 

digunakan perencana untuk menganalisa struktur. ETABS adalah program analisis 

struktural dengan tujuan khusus untuk mendesain bangunan dan menganalisis 

sistem bangunan struktur. Konsep dasar software ini, perancangan hanya membuat 

model yang erdiri dari sistem lantai, sistem rangka vertikal dan horizontal untuk 

menganalisis dan mendesain keseluruhan bangunan, apabila terjadi perubahan data 

dari suatu bagian maka secara otomatis program aka memperbaikinya saat itu juga. 

ETABS merupakan program analisa struktur yang dikembangkan oleh perusahaan 

Software Computers and Structure, Incorporated (CSI) yang berpusat di Barkeley, 

California, Amerika Serikat.  

ETABS digunakan secara spesifik untuk menganalisis struktur high rise 

building seperti perkantoran, apartemen, hotel dan lain-lain. Program ini secara 

khusus difungsikan untuk menganalisis perencanaan struktur seperti analisis frame 

baja, analisis frame beton, analisis baja komposit, analisis baja rangka batang dan 

analisis dinding geser.  

Dalam penelitian ini program ETABS yang digunakan versi 9.7.1. Secara 

umum langkah-langkah untuk pemodelan dan analisis struktur dengan software 

ETABS sebagai berikut: 
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1. Pada menu File > New Model > No selanjutnya muncul kotak dialoq 

“Building Plan System and Story Definition” kemudian masukkan data 

grid dan story dimension yang akan membantu pemodelan bangunan 

setelah itu pilih grid only. 

2. Input data material yang akan digunakan, menu Define > Material 

Properties > Add New Material. 

3. Input data dimensi kolom dan balok, menu Define > Frame Section. 

Untuk pelat dan dinding, menu Define > Wall/Slab/Deck Section.  

4. Input data respon spektrum sebagai beban gempa, menu Define > 

Response Spectrum Function > Add User Spectrum. Input data pada 

kotak dialoq Respons Spectrum Function Definition, kelas situs, Period 

dan Acceleration. 

5. Input data beban statis yang akan diterapkam pada bangunan, menu 

Define > Static Load Cases. 

6. Menentukan spektrum gempa. Pilih Define > Respon Spectrum Case 

kemudian muncul Define Respons Spectra klik Add New Spectrum. 

RSPX untuk respon arah X dengan Scale Factor U1 dan RSPY untuk 

respon arah Y dengan Scale Factor U2. 

7. Input kombinasi pembebanan, menu Define > Load Combination > Add 

New Combo kemudian isi scale factor setiap jenis beban pada masing-

masing kombinasi. 

8. Menggambar kolom, menu Draw > Draw Line Object > Create Column 

in Region kemudian pada Properties of Object tentukan tipe kolom yang 

akan digunakan. 
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9. Menggambar balok, menu Draw > Draw Line Object > Draw Line 

kemudian pada Properties of Object tentukan tipe balok yang akan 

digunakan. 

10. Menggambar pelat, menu Draw > Draw Area Object > Draw Area 

kemudian pada Properties of Object tentukan tipe plat yang akan 

digunakan.  

11. Menggambar dinding, menu Draw > Draw Area Object > Draw Walls 

kemudian pada Properties of Object tentukan tipe dinding yang akan 

digunakan. 

12. Input beban mati dan beban hidup pada pelat, menu Assign > Shell/Area 

Loads > Uniform. Pilih Load Cases Name antara Dead/ Live disesuaikan 

dengan jenis beban yang akan diinput. 

13. Menentukan jenis perletakan pada bagian dasar struktur dengan cara 

Select semua titik yang ada di story base kemudian pilih menu Assign > 

Joint/Point > Restraints/Support > pilih jenis perletakan yang akan 

digunakan. 

14. Setelah semua komponen struktur selesai digambar selanjutnya proses 

analisis. Pilih menu Analyze > Set Analysis Option > Full 3D pada Active 

of Freedom > Checklist pada Dynamic Analysis > Ok. Setelah itu klik 

menu Analysis > Run Analysis. 

2.2 Penelitian Relevan 

Ada beberapa penelitian yang relevan mengenai lokasi optimum outrigger 

pada bangunan tingkat tinggi beraturan dengan penelitian ini, antara lain: 
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1. Po Seng Kian dan Frits Torang Siahaan (2001) dari Department of Civil 

Engineering Universitas Kristen Petra dalam jurnal “The Use of Outrigger and 

Belt Truss System for High Rise Concrete Buildings”. 

Penelitian ini dilakukan dengan membuat model bangunan tingkat tinggi 

dengan sistem penahan gaya lateral shear wall dan outrigger. Model 

menggunakan analisis 3 dimensi dengan model sebuah gedung 60 lantai. Setiap 

lantai tipikal dengan ketinggian antar lantai 3,5m. Diasumsikan kolom, balok, 

shear wall dan outrigger menggunakan beton. Periode gempa ulang 50 tahun 

dan kemungkinan 0,63 menggunakan koefisien tekan Cf. Terdapat 5 variasi 

penempatan outrigger yaitu, variasi 1 model struktur tanpa outrigger, variasi 2 

struktur model dengan satu outrigger tipe A, variasi 3 struktur model dengan 

satu outrigger tipe B, variasi 4 struktur model dengan dua outrigger tipe A, dan 

variasi 5 struktur model dengan dua outrigger tipe B. Tipe A satu outrigger 

pada satu lantai sedangkan tipe B satu outrigger melewati dua lantai. Model 

dengan dua outrigger berarti satu outrigger tetap di atap sementara yang lain 

berubah-ubah untuk mencari lokasi optimum berdasarkan displacement 

terhadap beban gempa. Hasil penelitian untuk satu outrigger, lokasi optimum 

outrigger di lantai 36 (0,425 tinggi bangunan dari atas) dengan tipe B variasi 3 

mereduksi 14 % displacement model tanpa outrigger. Untuk dua outrigger, 

lokasi optimum outrigger satu di atap dan yang kedua di 0,475 tinggi bangunan 

dari atas dengan tipe B variasi 5 mereduksi 18,07% displacement model tanpa 

outrigger. 

2. P. M. B. Raj Kiran Nanduri, B. Suresh, MD. Ihtesham Hussain (2013), dari 

Department of Civil Engineering, Adama science and Technology University, 
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Adama, Ethiopia dalam jurnal “Optimum Position Of Outrigger System For 

High Rise Reinforced Concrete Buildings Under Wind And Earthquake 

Loadings” 

Penelitian ini menggunakan model bangunan tingkat tinggi 30 lantai tipikal 

seluas 30,5m x 30,5m dengan tinggi antar lantai 3m dan jarak antar kolom 5,5m. 

Beban angin dihitung berdasarkan IS 875 (bagian 3) dan beban gempa dihitung 

berdasarkan IS 1893 (bagian 1):2002 menggunakan model analisis respon 

spektrum. Model ini dianalisis menggunakan ETABS dengan 9 variasi pada 

table. Hasil penelitian ini drift dapat direduksi 4,8% jika outrigger di lantai 

paling atas dan 5,3% outrigger dilantai paling atas dengan belt truss ketika 

dibandingkan dengan drift struktur hanya dengan core wall. 18,55% dan 

23,06% mereduksi drift jika outrigger dipasang ditengah tinggi bangunan 

dengan dan tanpa belt truss. 

Tabel 2. 14 Variasi Penempatan Outrigger 

Variasi Lokasi Outrigger 

Variasi 1 - - 

Variasi 2 SOD - 

Variasi 3 SOD ¾ H 

Variasi 4 SOD ½ H 

Variasi 5 SOD ¼ H 

Variasi 6 SOD + BT  

Variasi 7 SOD + BT ¾ H 

Variasi 8 SOD + BT ½ H 

Variasi 9 SOD + BT ¼ H 
Catatan: SOD = Outrigger di lantai paling atas 

BT = Belt Truss 

3. Sreelakshmi S dan Shilpa Sara Kurian (2016) dari Department of Civil 

Engineering, SNGCE Kadayiruppu India, dalam jurnal berjudul “Study of 

Outrigger System for High Rise Buildings”. 
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Penelitian ini menggunakan model bangunan 40 lantai dengan jarak antar lantai 

3m. Beban angin dan beban gempa berdasarkan IS 875 (bagian 3) dan IS 1893-

2002 (bagian 1). Analisis menggunakan metode riwayat waktu dengan program 

ETABS nonlinear 2015. Ada 4 variasi penempatan outrigger yaitu, dilantai 

paling atas, di lantai paling atas dan di seperempat tinggi bangunan, di lantai 

paling atas dan setengah tinggi bangunan, di lantai paling atas dan tigaperempat 

tinggi bangunan. Satu outrigger meliputi tiga lantai bangunan. Hasil penelitian 

ini bahwa penempatan outrigger pada lantai atas dan tigaperempat tinggi 

bangunan dapat mereduksi displacement 65,49%, story drift 78,87% dan gaya 

geser dasar 60,94%.  

2.3 Kerangka Berpikir  

Gempa bumi merupakan peristiwa alam yang terjadi akibat lepasnya energi 

secara tiba-tiba. Pelepasan energi ini diakibatkan karena adanya deformasi lempeng 

tektonik yang terjadi pada kerak bumi. Indonesia merupakan negara yang terletak 

diantara beberapa lempeng tektonik yang aktif bergerak sehingga mengakibatkan 

sering terjadinya gempa bumi. Indonesia sudah seharusnya memiliki kesadaran 

untuk mengantisipasi keadaan ini. Dampak yang diakibatkan gempa pada bangunan 

rendah dan bangunan tinggi akan berbeda. Ketika sebuah bangunan menerima 

beban lateral maka bangunan akan memberikan respon. Respon bangunan yang 

dapat terlihat berupa getaran. Semakin besar getaran akibat beban lateral maka 

semakin besar resiko kerusakan yang terjadi pada bangunan. besar getaran 

bangunan dipengaruhi oleh kekakuan bangunan. Bangunan tinggi lebih beresiko 

mengalami kerusakan akibat gempa terlebih jika bangunan tinggi tersebut 

mempunyai ketidakberaturan vertikal. Salah satu bentuk antisipasi yang dapat 
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dilakukan untuk menambah kekakuan bangunan dengan membuat desain bangunan 

yang tahan tehadap gempa menggunakan sistem penahan gaya gempa atau beban 

lateral yaitu sistem outrigger.  

Outrigger berfungsi sebagai penahan beban lateral yang menghubungkan 

core dengan kolom yang terletak pada bagian terluar yang mengkonversi momen 

pada core menjadi pasangan gaya vertikal pada kolom. Sistem outrigger yang 

digunakan pada bangunan tingkat tinggi tidak dipasang pada setiap lantai bangunan. 

Pemasangan outrigger disesuaikan dengan kebutuhan dan perencanaan dari 

bangunan. Umumnya outrigger ditempatkan pada satu lantai atau lebih pada 

bangunan agar berfungsi maksimal namun tetap memperhatikan bentuk dan fungsi 

bangunan. 

Berdasarkan kondisi tersebut maka perlu dilakukan penelitian untuk 

mengetahui perilaku struktur bangunan tingkat tinggi dengan ketidakberaturan 

vertikal yang menggunakan outrigger terhadap beban gempa. 

2.4 Hipotesis Penelitian 

Berdasarkan kerangka teoritik dan kerangka berpikir diatas dapat 

dirumuskan hipotesis sebagai berikut: 

Diduga terdapat perbedaan respon struktur pada bangunan tingkat tinggi 

yang mempunyai ketidakberaturan vertikal lantai lunak dan ketidakberaturan massa 

dengan beberapa variasi penempatan outrigger terhadap beban gempa. 
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BAB III 

METODOLOGI PENELITIAN 

3.1 Waktu dan Tempat Penelitian 

Waktu penelitian dilakukan pada bulan September sampai November 2017. 

Penelitian dilakukan di Laboratorium Komputer Jurusan Teknik Sipil Fakultas 

Teknik Universitas Negeri Jakarta. 

3.2 Subjek Penelitian 

Penelitian ini menggunakan data struktur pada proyek St. Moritz 

Panakkukang 55 lantai yang berfungsi sebagai hotel dan apartemen. Data-data 

struktur yang digunakan dalam penelitian ini antara lain: 

1. Kolom  

Kolom yang digunakan pada penelitian ini terdiri dari dua jenis kolom pada 

setiap lantai bangunan yaitu K1 dan K2 seperti pada gambar 3.1. Dimensi 

kolom K1 dan K2 mempunyai beberapa dimensi seperti pada tabel 3.1 

dengan mutu beton K450 (fc’=37,35 Mpa). 

 

Gambar 3. 1 Kolom, Balok, dan Pelat Lantai Basement 1 
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Tabel 3. 1 Dimensi Kolom 

Letak 
Dimensi Kolom (mm) 

 K1 K2 

Lantai Basement 2 – Lower ground 1300 x 1300 1500 x 1500 

Lantai Ground Floor – Lantai 9 1200 x 1200 1400 x 1400 

Lantai 10 - lantai 22 800 x 1500 800 x 1850 

Lantai 23 - lantai 31 700 x 1200 700 x 1400 

Lantai 32 - lantai 40 550 x 1200 600 x 1400 

Lantai 41 - lantai 49 400 x 1200 500 x 1400 

 

2. Balok 

Balok yang digunakan pada penelitian ini terdiri dari balok induk dan balok 

anak. Balok induk meliputi B1P, B1, B2P, B2, BK, dan B3 sedangkan balok 

anak meliputi B1AP, B2AP, B2A, B3A, dan B4A. Balok induk dan balok 

anak tersebut mempunyai dimensi seperti pada tabel 3.2 dengan mutu beton 

K350 (fc’= 29,05 Mpa). Pada satu lantai bangunan menggunakan beberapa 

balok anak dan balok induk seperti pada gambar 3.1. 

Tabel 3. 2 Dimensi Balok 

Letak Notasi Dimensi Balok (mm) 

Basement 1- Ground Floor 

B1P 350 x 800 

B1AP 250 x 700 

B2P 300 x 600 

B3AP 250 x 500 

B4A 200 x 400 

Upper ground floor – lantai 9 

B1P 350 x 800 

B1AP 250 x 700 

B2P 300 x 600 

B3AP 250 x 500 

B4A 200 x 400 

BP2 600 x 1200 

Lantai 10- lantai 49 

B1 350 x 800 

B2 300 x 600 

B2A 250 x 600 

B3 300 x 500 

B4A 200 x 400 

BK 600 x 600 
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3. Pelat 

Pelat yang digunakan pada penelitian ini mempunyai beberapa dimensi 

ketebalan seperti pada tabel 3.3 dan menggunakan mutu beton K350 (fc’= 

29,05 Mpa). Pelat yang mempunyai ketebalan sama dibedakan oleh tulangan 

overstek. Pada sebagian lantai bangunan terdapat dua jenis pelat yang 

digunakan seperti pada gambar 3.1. 

Tabel 3. 3 Dimensi Pelat 

Letak Notasi Ketebalan (mm) 

Basement 1 S3 130 

Lower Ground 
S4 150 

S6 250 

Ground Floor – Lantai 4 S9 130 

Lantai 5- lantai 8 S18 130 

Lantai 9 
S13 150 

S20 130 

Lantai 10- atap 
S13 150 

S18 130 

 

4. Dinding geser 

Dinding geser yang digunakan pada penelitian ini ada enam jenis yaitu CW1, 

SW1, SW2, SW13, SW14 dan SW15. Semua jenis hear wall mempunyai 

ketebalan yang sama yaitu 400 mm. Perbedaannya adalah pada jumlah dan 

letak penulangan. Mutu beton yang digunakan untuk shear wall K350 (fc’= 

29,05 Mpa). Dinding geser CW1 berbentuk huruf C, dinding geser SW1, 

SW13, S14 dan SW15 berbentuk I arah vertikal sedangkan SW2 berbentuk 

I arah horizontal seperti pada gambar 3.1.  

5. Outrigger 

Outrigger yang digunakan pada penelitian ini ada dua jenis yaitu OR1 

dengan dimensi 800x800 mm dan OR2 dengan dimensi 400x800 mm. Mutu 

beton yang digunakan K450 (fc’= 37,35 Mpa). Outrigger terletak pada lantai 
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26 jika dihitung dari basement. Adanya outrigger pada lantai 26 

menyebabkan perubahan massa yang signifikan yang mengindikasikan 

bangunan ini mempunyai ketidakberaturan vertikal. 

3.3 Ketidakberaturan Vertikal Pada Bangunan 

Bangunan yang beraturan dan bangunan dengan ketidakberaturan akan 

mempunyai perilaku yang berbeda ketika menerima gaya gempa. Berdasarkan SNI 

1726 2012 ada dua jenis ketidakberaturan pada bangunan yaitu ketidakberaturan 

vertikal dan ketidakberaturan vertikal. Pada bangunan St. Morits Panakkukang akan 

ditinjau ketidakberaturan vertikal yang ada pada bangunan tersebut. 

3.3.1 Ketidakberaturan Lantai Lunak 

Pada bangunan St. Morits Panakkukang mempunyai ketinggian lantai antar 

tingkat yang beragam. Ketinggian lantai antar tingkat tertinggi pada lantai Lower 

Ground dan Ground Floor yaitu 7,00 m sedangkan pada lantai Upper Ground 

ketinggian lantai 5,50 m. Oleh karena itu dilakukan perhitungan untuk memastikan 

adanya ketidakberaturan lantai lunak atau soft story pada lantai tersebut. 

Perhitungan tersebut dilakukan sebagai berikut: 

1. Lantai Ground Floor (GF) 

Modulus Elastisitas, 𝐸 = 20000000 kN/m2 

Dimensi kolom 1  = 1200 mm x 1200 mm 

Dimensi kolom 2  = 1400 mm x 1400 mm 

Tinggi kolom, 𝑙  = 7,00 m 

Inersia kolom, 𝐼 

𝐼1 =
1

12
. 𝑏. ℎ3 =  

1

12
. 1,2. 1,23 = 0,1728 𝑚4  
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𝐼2 =
1

12
. 𝑏. ℎ3 =  

1

12
. 1,4. 1,43 = 0,3201 𝑚4  

Kekakuan kolom, 𝑘 

𝑘1 =
12. 𝐸. 𝐼

𝑙3
=  

12. 20000000.0,1728

73
= 120.909,6 𝑘𝑁/𝑚 

𝑘2 =
12. 𝐸. 𝐼

𝑙3
=  

12. 20000000.0,3201

73
= 224.000 𝑘𝑁/𝑚 

Total kekakuan kolom  

𝑘1 + 𝑘2 = (12.120909,6 ) + (12.224000) =  4.138.915 𝑘𝑁/𝑚 

2. Lantai Upper Ground (UG) 

Modulus Elastisitas, 𝐸 = 20000000 kN/m2 

Dimensi kolom 1  = 1200 mm x 1200 mm 

Dimensi kolom 2  = 1400 mm x 1400 mm 

Tinggi kolom, 𝑙  = 5,50 m 

Inersia kolom, 𝐼 

𝐼1 =
1

12
. 𝑏. ℎ3 =  

1

12
. 1,2. 1,23 = 0,1728 𝑚4  

𝐼2 =
1

12
. 𝑏. ℎ3 =  

1

12
. 1,4. 1,43 = 0,3201 𝑚4  

Kekakuan kolom, 𝑘 

𝑘1 =
12. 𝐸. 𝐼

𝑙3
=  

12. 20000000.0,1728

5,53
= 249.268,2 𝑘𝑁/𝑚 

𝑘2 =
12. 𝐸. 𝐼

𝑙3
=  

12. 20000000.0,3201

5,53
= 461.800,2 𝑘𝑁/𝑚 

 

Total kekakuan kolom  

𝑘1 + 𝑘2 = (12.249.268,2) + (12.461.800,2) = 8.532.820 𝑘𝑁/𝑚 
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Perbandingan kekakuan total kolom pada lantai GF dan UG 

4.138.915 𝑘𝑁/𝑚 <  70%(8.532.820 𝑘𝑁/𝑚) 

4.138.915 𝑘𝑁/𝑚 < 5.972.974,3 𝑘𝑁/𝑚 

Berdasarkan hasil perhitungan di atas didapatkan bahwa kekakuan total 

kolom pada ground floor kurang dari 70% kekakuan total kolom pada lantai 

diatasnya yaitu kekakuan total kolom lantai upper ground sehingga pada 

lantai ground floor bangunan ini terdapat ketidakberaturan tingkat lunak 

atau soft story. Dengan cara perhitungan yang sama didapatkan bahwa pada 

lantai 7, lantai 8, lantai 14 dan lantai 26 merupakan lantai soft story. 

3.3.2 Ketidakberaturan Massa 

Sebuah bangunan akan dikatakan memiliki ketidakberaturan massa apabila 

jika massa efektif semua tingkat lebih dari 150% massa efektif tingkat di dekatnya. 

Pada bangunan St. Morits Panakkukang yang menggunakan sistem outrigger 

sebagai sistem tambahan penahan gaya lateral pada lantai 26 menyebabkan 

penambahan massa yang signifikan. Hal ini dikarenakan sistem outrigger yang 

bermaterial beton dan dimensinya yang relatif besar. Untuk memastikan adanya 

ketidakberaturan massa pada bangunan ini akan dibandingkan massa pada lantai 25 

dan massa pada lantai 26 dimana outrigger berada. 

Massa lantai 26 ≥ 150% massa lantai 25 

30085,87 kN ≥ 150% (9074,067 kN) 

30085,87 kN ≥ 13611,101 kN 

Dari perbandingan diatas maka dapat disimpulkan bahwa adanya outrigger 

pada lantai 26 sebagai sistem penahan gaya lateral tambahan pada struktur 

bangunan menyebabkan ketidakberaturan massa. 
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3.4 Variasi Pemodelan Struktur 

Pada penelitian ini akan dilakukan variasi pemodelan struktur sebagai 

perbandingan dengan memindahkan Ourtigger dari lantai 26. Namun sebelum 

pemindahan letak outrigger akan ada dibuat variasi pemodelan struktur tanpa 

outrigger sebagai pembanding seberapa perlu penggunaan outrigger pada bangunan 

St. Morits Panakkukang Tower A. Variasi yang akan diberikan antara lain ialah 

variasi 1 dimana outrigger diletakkan pada ¼ tinggi bangunan (lantai 14), variasi 2 

dimana outrigger diletakkan pada ¾ tinggi bangunan (lantai 36), dan variasi 3 

dimana outrigger diletakkan pada lantai atap bangunan. Variasi-variasi tersebut 

akan dimodelkan seperti pada gambar 3.3. Penentuan variasi berdasarkan 

penelitian-penelitian relevan yang memberikan variasi outrigger pada 1/4h dari 

dasar bangunan, 3/4h dari dasar bangunan dan atap bangunan.  
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a. Tanpa OT b. Variasi 1 c. Eksisting d. Variasi 2 e. Variasi 3 

Gambar 3. 2 Variasi Penempatan Outrigger Pada Struktur 

3.5 Pembebanan Struktur 

Pembebanan struktur yang direncanakan untuk beban mati dan beban hidup 

berdasarkan SNI 1727-2013 sedangkan untuk beban gempa berdasarkan SNI 1726-

2012. 
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3.5.1 Beban Mati 

Beban mati yang dihitung dibedakan berdasarkan fungsi lantai bangunan 

yaitu lantai basement, lantai hotel dan apartmen dan lantai atap. 

a. Lantai Basement 

- Adukan semen (tebal 3 cm)   = 0,63 kN/m2 

- Mekanikal dan elektrikal   = 0,25 kN/m2 

Total beban mati     = 0,88 kN/m2 

b. Lantai ground sampai lantai 49 

- Adukan semen (tebal 3 cm)   = 0,63 kN/m2 

- Keramik     = 0,24 kN/m2 

- Mekanikal dan elektrikal   = 0,25 kN/m2 

- Plafond dan penggantung   = 0,18 kN/m2 

Total beban mati     = 1,30 kN/m2 

c. Lantai Atap 

- Adukan semen (tebal 3 cm)   = 0,63 kN/m2 

- Mekanikal dan elektrikal   = 0,25 kN/m2  

- Water proofing                 = 0,14 kN/m2 

- Plafond dan penggantung   = 0,18 kN/m2 

Total beban mati    = 1,20 kN/m2 

3.5.2 Beban Hidup 

Beban hidup yang dihitung berdasarkan fungsi lantai bangunan yaitu lantai 

basement, lantai hotel dan apartemen, lantai atap dan tangga. 

a. Lantai basement 
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Beban hidup parkiran    = 3,92 kN/m2 

b. Lantai lower ground sampai 49 

Beban hidup hotel    = 1,92 kN/m2 

c. Lantai atap 

Beban hidup lantai atap   = 0,96 kN/m2 

d. Tangga  

Beban hidup tangga    = 2,94 kN/m2 

3.5.3 Beban Gempa 

Beban gempa direncanakan berdasarkan prosedur respon spektrum dalam 

SNI 1726-2012 sebagai berikut: 

a. Kategori resiko struktur bangunan  

Bangunan apartemen berdasarkan tabel 2.2 termasuk kategori resiko II. 

b. Faktor keutamaan gempa, Ie 

Faktor keutamaan gempa untuk kategori resiko II berdasarkan tabel 2.3 

adalah 1,0. 

c. Parameter percepatan terpetakan Ss dan S1 

Pada wilayah Panakkukang dengan kelas situs SC, nilai Ss adalah 0,317g dan 

nilai S1 adalah 0,142g. 

d. Koefisien situs untuk desain seismic Fa dan Fv 

- Berdasarkan tabel 2.8 faktor amplifikasi getaran terkait percepatan pada 

getaran perioda pendek dengan kelas situs SC, Fa = 1,2 

- Berdasarkan tabel 2.9 faktor amplifikasi getaran terkait percepatan pada 

getaran perioda 1 detik dengan kelas situs SC, Fv = 1,658 
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e. Parameter spektrum respons percepatan SMS dan SM1 

- SMS = Fa x SS = 1,2 x 0,317 = 0,3804 

- SM1 = Fv x S1 = 1,658 x 0,142 = 0,235 

f. Parameter percepatan spectral desain SDS dan SD1 

- SDS = 2/3 x SMS = 2/3 x 0,3804 = 0,2536 

- SD1 = 2/3 x SM1 = 2/3 x 0,235 = 0,1566 

g. Kurva respons spektrum desain 

Menghitung perioda batas perioda pendek: 

𝑇0 = 0,2
𝑆𝐷1

𝑆𝐷𝑆
= 0,2 

0,1566

0,2536
= 0,1235 𝑑𝑒𝑡𝑖𝑘 

𝑇𝑆 =
𝑆𝐷1

𝑆𝐷𝑆
=  

0,1566

0,2536
= 0,0,6175 𝑑𝑒𝑡𝑖𝑘 

Menghitung percepatan respons spectral (Sa): 

- Untuk T ≤ T0 : 𝑆𝑎 = 𝑆𝐷𝑆 (0,4 + 0,6
𝑇

𝑇0
) 

  𝑆𝑎 = 0,2536 (0,4 + 0,6
𝑇

0,1235
) 

- Untuk T0 ≤ T ≤ TS : 𝑆𝑎 = 𝑆𝐷𝑆 = 0,2536 

- Untuk T > Ts  : 𝑆𝑎 =  
𝑆𝐷1

𝑇
=  

0,1566

𝑇
 

Sehingga kurva respon spektrum akan menjadi seperti gambar  
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Gambar 3. 3 Kurva Respon Spektrum 

3.5.4 Kombinasi Pembebanan 

Nilai SDS adalah 0,2536 sehingga berdasarkan tabel 2.4 termasuk kategori 

desain seismik B. Nilai SDS disubtitusikan ke persamaan kombinasi pembebanan 

sehingga didapat persamaan seperti berikut: 

1. 1,4 D 

2. 1,2 D + 1,6 L 

3. 1,266 D + 1,0 L + 0,3 QEx + 1,0 QEy 

4. 1,236 D + 1,0 L - 0,3 QEx + 1,0 QEy 

5. 1,134 D + 1,0 L - 0,3 QEx + 1,0 QEy 

6. 1,164 D + 1,0 L + 0,3 QEx - 1,0 QEy 

7. 1,266 D + 1,0 L + 1,0 QEx + 0,3 QEy 

8. 1,236 D + 1,0 L - 1,0 QEx + 0,3 QEy 

9. 1,134 D + 1,0 L - 1,0 QEx + 0,3 QEy 

10. 1,164 D + 1,0 L + 1,0 QEx - 0,3 QEy 

11. 0,834 D + 0,3 QEx + 1,0 QEy 

12. 0,864 D - 0,3 QEx + 1,0 QEy 

0

0.05

0.1

0.15

0.2

0.25

0.3

SA
 (

g)

Waktu (T)
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13. 0,966 D - 0,3 QEx - 1,0 QEy 

14. 0,936 D + 0,3 QEx - 1,0 QEy 

15. 0,834 D + 1,0 QEx + 0,3 QEy 

16. 0,864 D - 1,0 QEx + 0,3 QEy 

17. 0,966 D - 1,0 QEx - 0,3 QEy 

18. 0,834 D + 1,0 QEx - 0,3 QEy 

Hasil penelitian pendahuluan didapatkan setelah memasukkan 18 

kombinasi tersebut dan melakukan run analysis pada pemodelan struktur eksisting. 

Run analysis menghasilkan output yang menunjukkan respon struktur terhadap 

pembebanan. Nilai simpangan dari 18 kombinasi pembebanan dapat dilihat pada 

gambar 4.1 simpangan arah X dan gambar 4.2 nilai simpangan arah Y. Berdasarkan 

output run analysis dengan parameter respon struktur simpangan didapatkan bahwa 

kombinasi 3 memiliki nilai simpangan terbesar dari arah X maupun arah Y pada 

pemodelan eksisting. Kombinasi 3 adalah 1,266 D + 1,0 L + 0,3 QEx + 1,0 QEy 

terdiri dari beban mati, beban hidup, beban gempa arah X, dan beban gempa arah 

Y. Selanjutnya kombinasi pembebanan 3 juga akan digunakan pada semua variasi 

pemodelan. 
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Sumber: Data Hasil Penelitian 

Gambar 3. 4 Nilai Displacement Arah X 

 

 

Sumber: Data Hasil Penelitian 

Gambar 3. 5 Nilai Displacement Arah Y 

 

3.6      Metodologi Penelitian 

Penelitian akan dilaksanakan dengan alur seperti pada diagram dibawah ini. 
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Gambar 3. 6 Diagram Alur Penelitian Gambar 3. 7 Diagram Alur 

Pemodelan Struktur 

 

3.6 Teknik Analisis Data 

Teknik analisis data yang digunakan dalam penelitian ini adalah analisis 

deskriptif. Analisis deskristif yaitu mendeskripsikan data hasil penelitian yang 

didapat dalam bentuk tabel, diagram dan grafik.

Mulai

Input Data Teknis Bangunan

Jumlah Lantai dan Ketinggian Lantai

Menentukan Material dan 
Elemen yang Digunakan

Membuat Model Elemen Struktur

Kolom, Balok, Pelat, Dinding Geser, 
Outrigger

Pembebanan

Beban Hidup, Mati dan Gempa

Kombinasi Pembebanan

Variasi Penempatan Outrigger

Running Model

Selesai

Mulai

Studi Literatur

Mengumpulkan Data 
Teknik dan Struktur

Input Beban Mati , Beban 
Hidup dan Beban Gempa

Running Model

Output Penelitian:

- Displcement

- Simpangan Antar 
Lantai

- Gaya Geser Dasar

Analisis Output Penelitian

Kesimpulan

Selesai
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BAB IV 

HASIL PENELITIAN DAN PEMBAHASAN 

4.1 Hasil Penelitian 

Hasil penelitian didapatkan setelah melakukan run analysis pada setiap 

variasi pemodelan struktur dengan kombinasi pembebanan 3 sehingga didapatkan 

hasil untuk parameter-parameter sebagai berikut. 

4.1.1 Base Shear  

Output dari proses run analysis menggunakan program ETABS berupa nilai 

base shear sebagai salah satu respon struktur akibat beban gempa. Nilai base shear 

yang dilihat pada mode 1 karena mode 1 adalah bentuk pertama dari bangunan 

setelah bangunan menerima gaya gempa dari dasar. Pengambilan nilai base shear 

dari mode 1 juga untuk menghindari adanya bentuk puntiran atau rotasi pada 

bangunan yang terdapat pada mode-mode selanjutnya. Nilai base shear pada 

bangunan eksisting dan variasi dapat dilihat pada tabel 4.1. 

Tabel 4. 1 Nilai Base Shear Sebelum Terkoreksi 

Model 
Base Shear (kN) 

Periode (s) Berat 

Struktur (kN) Arah X Arah Y 

Tanpa Outrigger 1617.03 1282.44 0.5492 515785.666 

Variasi 1 1580.81 1224.59 0.5794 533446.824 

Eksisting 1699.25 1411.32 0.5738 533446.824 

Variasi 2 1659.42 1315.06 0.5490 530922.275 

Variasi 3 1824.96 1461.83 0.5925 530922.275 

Sumber: Data Hasil Penelitian 

Berdasarkan SNI 03-1726-2012 nilai base shear atau gaya geser dasar tidak 

boleh kurang dari 85% dari gaya geser dasar yang dihitung menggunakan metode 
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analisis statik ekuivalen. Jika syarat ini tidak terpenuhi maka faktor skala perlu 

dikoreksi berdasarkan ordinat ragam spektrumnya. Nilai gaya geser dasar pada 

tabel 4.1 menggunakan metode analisis respon dinamis sehingga nilai gaya geser 

dasar tersebut harus sama atau lebih dari 85% nilai gaya geser dasar metode analisis 

statik ekuivalen. Berdasarkan hasil perhitungan gaya geser dasar metode statik 

ekuivalen pada lampiran 1, semua pemodelan mempunyai nilai gaya geser dasar 

yang lebih kecil sehingga faktor skala perlu dikoreksi. Nilai faktor skala sebelum 

terkoreksi dan setelah koreksi dapat dilihat pada tabel 4.2. 

Tabel 4. 2 Nilai Faktor Skala Setelah Koreksi 

Model Kasus Arah Faktor Skala 

Awal 

Faktor Skala 

Terkoreksi 

Tanpa 

Outrigger 

RSPX 
U1 1.2263 11.8830 

U2 0.3679 3.5649 

RSPY 
U1 0.3679 4.4950 

U2 1.2263 14.9833 

Variasi 1 

RSPX 
U1 1.2263 11.9140 

U2 0.3679 3.5742 

RSPY 
U1 0.3679 4.6139 

U2 1.2263 15.3797 

Eksisting 

RSPX 
U1 1.2263 11.1918 

U2 0.3679 3.3575 

RSPY 
U1 0.3679 4.0425 

U2 1.2263 13.4751 

Variasi 2 

RSPX 
U1 1.2263 11.9214 

U2 0.3679 3.5764 

RSPY 
U1 0.3679 4.5129 

U2 1.2263 15.0431 

Variasi 3 RSPX U1 1.2263 10.0459 
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U2 0.3679 3.0138 

RSPY 
U1 0.3679 3.7624 

U2 1.2263 12.5414 

 

Faktor skala yang telah terkoreksi diinput pada masing-masing pemodelan 

struktur dan dilakukan run analysis lagi maka akan didapatkan nilai base shear yang 

sesuai dengan syarat pada SNI 03-1726-2012. Nilai base shear terkoreksi dapat 

dilihat pada tabel 4.3. 

Tabel 4. 3 Nilai Base Shear Setelah Koreksi 

Model 
Base Shear (kN) 

Periode (s) 
Berat 

Struktur (kN) Arah X Arah Y 

Tanpa Outrigger 15669.23 15669.25 0.5492 515785.666 

Variasi 1 15358.54 15358.17 0.5794 533446.824 

Eksisting 15508.13 15508.23 0.5738 533446.824 

Variasi 2 16132.13 16132 0.5490 530922.275 

Variasi 3 14950.17 14950.14 0.5925 530922.275 

Sumber: Data Hasil Penelitian 

4.1.2 Displacement  

 Displacement atau simpangan ditinjau pada arah X dan arah Y untuk setiap 

pemodelan struktur. Nilai displacement diambil dari salah satu titik dimana titik 

tersebut menerus dari lantai basement sampai lantai atap. Titik ini berlaku untuk 

peninjuan displacement pada semua pemodelan. Nilai displacement dari seluruh 

pemodelan dapat dilihat pada tabel 4.4 untuk arah X dan tabel 4.5 untuk arah Y. 
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Tabel 4. 4 Nilai Displacement Arah X 

Lantai 

Displacement Arah X (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 17.4777 17.1712 16.4967 15.1871 17.1148 

Sumber: Data Hasil Penelitian 

 

Tabel 4. 5 Nilai Displacement Arah Y 

Lantai 

Displacement Arah Y (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 36.5834 36.2874 35.5731 33.8085 34.1801 

Sumber: Data Hasil Penelitian 

4.1.3 Story Drift 

Nilai story drift diperoleh dari selisih simpangan yang terjadi pada suatu 

lantai dengan simpangan pada lantai sebelumnya. Berdasarkan nilai displacement 

atau simpangan pada subbab sebelumnya, nilai story drift dari semua pemodelan 

dapat dilihat pada tabel 4.6 untuk arah X dan tabel 4.7 untuk arah Y. 

Tabel 4. 6 Nilai Story Drift Arah X 

Lantai 

Story Drift Arah X (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 1.0612 0.9509 0.8636 0.5198 0.4491 

Sumber: Data Hasil Penelitian 

Tabel 4. 7 Nilai Story Drift Arah Y 

Lantai 

Story Drift Arah Y (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 2.5782 2.5331 2.643 2.1937 1.5481 

Sumber: Data Hasil Penelitian 
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4.2 Pembahasan 

4.2.1 Analisa Base Shear 

Base shear adalah perkiraan besarnya gaya lateral yang akan diterima 

bangunan dari gerakan tanah akibat gaya gempa. Ada beberapa faktor yang dapat 

mempengaruhi nilai base shear diantaranya kondisi tanah, potensi aktivitas 

seismik, tingkat daktilitas yang terkait dengan berbagai konfigurasi struktural, berat 

struktur dan waktu getar alami struktur saat menerima gaya gempa. 

 Gambar 4.1 merupakan perbandingan nilai base shear dari seluruh 

pemodelan struktur untuk arah X dan arah Y. Terlihat perbedaan nilai base shear 

pada setiap pemodelan jika dibandingkan dengan pemodelan lainnya. 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 1 Base Shear Arah X dan Arah Y 

Dari grafik tersebut dapat dilihat bahwa variasi 2 dimana outrigger 

ditempatkan pada ¾ h bangunan mempunyai nilai base shear arah X dan arah Y 

terbesar dibandingkan dengan variasi lainnya dan bangunan eksisting. Berdasarkan 

grafik tersebut penggunaan outrigger pada ¾ h bangunan menyebabkan kenaikan 

base shear sebesar 4,02% terhadap struktur eksisting dengan outrigger pada ½ h 

bangunan. Seperti yang telah disebutkan sebelumnya bahwa ada beberapa faktor 

yang mempengaruhi nilai base shear diantaranya daktilitas struktur yang berkaitan 

Tanpa OT Variasi 1 Eksisting Variasi 2 Variasi 3
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dengan konfigurasi struktur. Proyek St. Moritz Panakukang Tower A memiliki 

denah dengan arah X 3,05 kali arah Y yang mengabkibatkan lebih besarnya nilai 

base shear pada arah X. 

Selain daktilitas, periode struktur merupakan salah satu faktor yang 

mempengaruhi base shear. Periode struktur merupakan waktu yang diperlukan 

untuk struktur kembali kebentuk semula setelah menerima gaya gempa. Periode 

dapat dipengaruhi oleh massa dan kekakuan struktur. Semakin kaku sebuah struktur 

maka periode akan semakin kecil. Berikut adalah grafik dari periode stuktur pada 

semua pemodelan struktur.  

 

Sumber: Data Hasil Penelitian 

Gambar 4. 2 Periode Seluruh Pemodelan Struktur 

Dari grafik dibawah ini dapat dilihat bahwa variasi 2 yang mempunyai base 

shear terbesar juga mempunyai periode terkecil jika dibandingan dengan struktur 

eksisting yang menggunakan outrigger pada ½ h bangunan. Sementara variasi 4 

mempunyai nilai periode tertinggi mempunyai nilai base shear terkecil. Periode 

varisasi 3 menurun 4,3% terhadap periode eksisting sedangkan periode tanpa 

outrigger yang tidak menggunakan outrigger menurun 4,28% terhadap periode 

eksisting. Untuk variasi 2 yang menggunakan outrigger pada ¼ h bangunan dan 
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variasi 4 yang menggunakan outrigger pada atap bangunan mengalami kenaikan 

periode 0,97% dan 3,26% secara berturut-turut.   

Selain periode ada juga faktor massa yang dapat mempengaruhi nilai base 

shear. Pemindahan letak outrigger pada beberapa variasi menyebabkan adanya 

perbedaan massa bangunan pada pemodelan struktur. Seperti pada variasi 1 yang 

menghilangkan outrigger pada struktur menyebabkan stuktur lebih ringan 

dibandingkan dengan variasi 2, eksisting, 3 dan 4. Massa variasi 2 sama dengan 

eksisting karena pada variasi 2 dimana outrigger diletakkan pada lantai 9 memiliki 

tinggi lantai yang cukup untuk merelokasi outrigger dengan panjang yang sama 

seperti panjang outrigger eksisting. Sedangkan variasi 2 dan eksisting lebih berat 

dari pada variasi 3 dan 4, hal ini karena pemindahan outrigger pada variasi tersebut 

tidak merubah tinggi lantai bangunan yang lebih rendah dari tinggi lantai pada 

variasi 2 dan eksisting. Panjang outrigger pada variasi 3 dan 4 yang menyesuaikan 

dengan tinggi lantai tersebut. Perbedaan massa struktur seluruh pemodelan dapat 

dilihat pada tabel 4.8. 

Tabel 4. 8 Massa Struktur Seluruh Pemodelan 

Model Berat Struktur (kN) 

Tanpa Outrigger 515785.666 

Variasi 1 533446.824 

Eksisting 533446.824 

Variasi 2 530922.275 

Variasi 3 530922.275 

Sumber: Data Hasil Penelitian 

Variasi 3 yang mempunyai nilai base shear terbesar dan periode terkecil 

namun dengan massa struktur yang lebih ringan dari pada variasi 2 dan eksisting. 
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Variasi 1 mempunyai massa struktur paling ringan namun mempunyai base shear 

dan periode yang lebih baik dibandingkan dengan variasi 2, 3, dan 4. 

4.2.2 Analisa Displacement 

Displacement atau simpangan merupakan nilai simpangan yang terjadi pada 

suatu lantai bangunan yang diukur dari lantai dasar bangunan itu sendiri. Nilai ini 

termasuk salah satu parameter kegempaan yang dapat digunakan untuk mengetahui 

tingkat kekakuan sebuah struktur bangunan. Semakin kecil nilai simpangan pada 

bangunan maka semakin besar atau tinggi tingkat kekakuan struktur bangunan. 

Sebaliknya jika semakin besar nilai displacement maka semakin rendah tingkat 

kekakuan bangunan tersebut. Umumnya nilai maksimum displacement terjadi pada 

lantai atap bangunan. Nilai displacement maksimum pada arah X dan arah Y dari 

seluruh pemodelan struktur dengan beberapa variasi penempatan outrigger dan 

tanpa outrigger dapat dilihat pada gambar 4.3 dan 4.4. 

.  

Sumber: Data Hasil Penelitian 

Gambar 4. 3 Nilai Displacement Maksimum Arah X 

Berdasarkan grafik diatas nilai displacement pada arah X pada pemodelan 

struktur tanpa outrigger menunjukkan nilai displacement terbesar jika 
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dibandingkan dengan nilai displacement dari pemodelan eksisting dan variasi-

variasi pemindahan outrigger sementara nilai displacement terkecil ditunjukkan 

oleh variasi 2. 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 4 Nilai Displacement Maksimum Arah Y 

Berdasarkan gambar tersebut terlihat bahwa sama seperti nilai displacement 

pada arah X, nilai displacement maksimum pada arah Y terjadi pada variasi 

pemodelan tanpa outrigger yaitu 36,58 mm. Sementara itu nilai displacement 

terkecil ditunjukkan oleh variasi 2 dengan nilai 33,80 mm. Selanjutnya nilai 

displacement pada setiap variasi akan dijabarkan seperti dibawah ini. 

1. Tanpa Outrigger 

Tanpa Outrigger merupakan pemodelan struktur yang tidak 

menggunakan outrigger sebagai sistem tambahan penahan gaya lateral. 

Variasi ini ada sebagai dasar perlu atau tidaknya penggunaan outrigger 

sebagai sistem tambahan penahan gaya lateral pada struktur bangunan 

Tower A St. Morits Panakkukang. Grafik 4.5 menunjukan nilai 

displacement pada pemodelan struktur tanpa outrigger dimana nilai 

maksimum displacement terdapat di lantai atap sebesar 17,47 mm pada 
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arah X dan 36,58 mm pada arah Y. Dari hasil tersebut jika dibandingkan 

dengan model eksisting yang menggunakan outrigger terjadi kenaikan 

nilai displacement sebesar 2,84%. Kenaikan nilai displacement yang 

tidak besar tersebut dikarenakan struktur bangunan yang sudah kaku 

tanpa adanya struktur tambahan sebagai sistem penahan gaya lateral. 

Hal ini dapat dilihat dari posisi dan jumlah core wall dan shear wall 

yang ada pada struktur tersebut. Core wall dan shear wall yang berada 

pada inti bangunan dan berjumlah banyak mampu menahan gaya lateral 

yang diterima bangunan. Secara denah bangunan yang lebih lebar pada 

arah X, akan terlihat bahwa konfigurasi core wall dan shear wall yang 

sejajar arah X akan bekerja dengan baik dalam menahan beban gempa. 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 5 Nilai Displacement Tanpa Outrigger Arah X dan Arah Y 

2. Variasi 1 
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Variasi 1 merupakan variasi dimana outrigger di tempatkan pada lantai 

14 atau ¼ h bangunan. Pada variasi ini nilai displacement juga 

mengalami penurunan sebesar 1,78% pada arah X sedangkan pada arah 

Y mengalami penurunan 0,82%. Pada grafik dibawah ini dapat dilihat 

dampak penggunaan outrigger pada lantai 14. Dimana pada lantai 

selanjutnya yakni lantai 15, lantai 16 dan seterusnya terlihat mengalami 

penurunan nilai displacement pada arah X maupun arah Y. Namun jika 

diamati dengan teliti nilai displacement pada lantai-lantai di bawah 

lantai 14 lebih besar dibandingkan dengan nilai displacement lantai-

lantai dibawah lantai 14 pada pemodelan struktur tanpa outrigger. Hal 

ini dipengaruhi oleh adanya ourtigger yang bermaterial beton dan 

berjumlah banyak sehingga pada lantai 14 massa menjadi sangat besar. 

Oleh karena itu pada variasi ini terdapat ketidakberaturan massa yang 

mempengaruhi perilaku struktur. Meskipun keberadaan outrigger dapat 

menambah kekakuan struktur namun keberadaannya juga menambah 

ketidakberaturan bangunan.  



77 

 

 

 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 6 Nilai Displacement Variasi 1 Pada Arah X dan Arah Y 

3. Eksisting 

Merupakan pemodelan struktur bangunan eksisting dimana outrigger 

berada pada lantai 26. Perbandingan nilai displacement arah X dan arah 

Y dapat dilihat pada gambar 4.9. Pada pemodelan ini nilai displacement 

menurun sebesar 5,95% pada arah X dan menurun sebesar 2,84% pada 

arah Y jika dibandingkan dengan pemodelan struktur tanpa outrigger. 

Namun jika dibandingkan dengan pemodelan pada variasi 1 yang 

mempunyai massa sama, pemodelan eksisting lebih baik dalam hal 

menurunkan nilai displacement. Hal ini disebabkan outrigger pada 

lantai 26 memiliki lengan ke atap lebih pendek dari pada variasi 1 

sehingga kinerja outrigger lebih besar pada bangunan. Namun 

penurunan nilai displacement variasi ini juga dinilai tidak signifikan 

mengingat banyaknya balok outrigger yang dipasang untuk 

menghubungkan seluruh kolom untuk memperkaku bangunan. 
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Banyaknya balok outrigger mengakibatkan kenaikan massa lantai 

sehingga pada variasi ini juga terdapat ketidakberaturan massa pada 

bangunan yang mempengaruhi perilaku bangunan terhadap beban 

gempa. 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 7 Nilai Displacement Eksisting Pada Arah X dan Arah Y 

4. Variasi 2 

Variasi 2 merupakan variasi yang memindahan outrigger pada ¾ h 

bangunan dari dasar atau lebih tepatnya pada lantai 41. Perbandingan 

nilai displacement arah X dan arah Y dapat dilihat pada gambar 4.8. 

Pada variasi ini nilai displacement pada arah X sebesar 15,18 mm atau 

turun 15,08% jika dibandingkan dengan nilai displacement pada arah X 

pemodelan tanpa outrigger. Pada arah Y nilai displacement 33,80 mm 

juga mengalami penurunan sebesar 8,21% jika dibandingkan dengan 

nilai displacement pemodelan tanpa outrigger. Variasi ini menunjukkan 

nilai displacement yang paling kecil dari seluruh variasi penempatan 
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outrigger dan tanpa outrigger. Pada variasi ini outrigger terletak pada 

lantai 36 yang mempunyai tinggi lantai 3,2 m sehingga membuat 

struktur lebih kaku terbukti dengan nilai displacement yang kecil begitu 

juga dengan periode. Berbeda dengan variasi 1 yang ketinggian 

lantainya 5,6 m dan eksisting yang ketinggian lantainya 6,0 m. Dengan 

tinggi kolom yang besar tersebut tentu kekakuan kolom berkurang dan 

pada variasi 1 dan eksisting outrigger berada pada lantai lunak atau soft 

story serta ketidakberaturan massa akibat adanya outrigger sehingga 

kekakuan struktur berkurang. 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 8 Nilai Displacement Variasi 2 Pada Arah X dan Arah Y 

5. Variasi 3 

Pada variasi 3 outrigger diletakkan pada lantai 55 atau atap bangunan. 

Pada variasi ini nilai displacement pada arah X dan arah Y dapat dilihat 

pada gambar 4.9. Nilai displacement arah X 17,11 mm atau menurun 

sebesar 2,12% dibandingkan dengan pemodelan tanpa outrigger. 

Sedangkan nilai displacement arah Y 34,18 mm atau menurun sebesar 

7,03% jika dibandingkan dengan pemodelan struktur tanpa outrigger. 
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Penurunan ini lebih besar dibandingkan dengan variasi 1 dan eksisting. 

Hal ini disebabkan oleh penempatan outrigger pada atap bangunan dan 

pengukuran nilai displacement juga pada atap bangunan sehingga efek 

penggunaan outrigger terlihat. Namun adanya outrigger pada lantai atap 

mengakibatkan adanya ketidakberaturan massa yang mempengaruhi 

periode bangunan. 

 

Sumber: Data Hasil Penelitian 

Gambar 4. 9 Nilai Displacement Variasi 3 Pada Arah X dan Arah Y 

 Nilai displacement dari semua pemodelan variasi untuk arah X dan arah Y 

masih dalam batas aman jika dihitung sebagai defleksi pusat massa. Berdasarkan 

persamaan tersebut nilai simpangan tidak boleh melebihi batas simpangan ijin 

seperti pada tabel 4.9.  

Tabel 4. 9 Kontrol Nilai Displacement 

Model 
Simpangan 

Arah X 

Simpangan 

Arah Y 

Simpangan 

Ijin 

Keterangan 

Arah X Arah Y 

Tanpa OT 96,13 201,21 4062 Aman Aman 

Variasi 1 94,44 199,60 4062 Aman Aman 

Eksisting 90,73 195,65 4062 Aman Aman 
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Variasi 2 83,53 185,95 4062 Aman Aman 

Variasi 3 94,13 187,79 4062 Aman Aman 

   

4.2.3 Analisa Story Drift 

Story drift menujukkan nilai simpangan yang terjadi pada suatu lantai 

diukur dari lantai sebelumnya. Nilai ini diperoleh dari selisih nilai simpangan lantai 

yang ditinjau dengan nilai simpangan lantai sebelumnya. Seperti parameter lainnya 

nilai story drift dapat menunjukkan tingkat kekakuan struktur sebuah bangunan 

setelah menerima beban gempa. Semakin kecil nilai story drift atau simpangan 

antar tingkat maka semakin tinggi tingkat kekakuan sebuah struktur sebaliknya 

semakin besar story drift maka semakin rendah tingkat kekakuannya. Semakin 

tinggi tingkat kekakuan struktur sebuah bangunan semakin aman bangunan tersebut 

dari bahaya keruntuhan struktur yang dapat membahayakan jiwa pengguna 

bangunan. 

Pada gambar 4.10 dan gambar 4.11 merupakan grafik perbandingan nilai 

story drift dari seluruh pemodelan struktur tanpa outrigger dan dengan beberapa 

variasi penempatan outrigger pada struktur pada arah X dan arah Y. 

Berdasarkan grafik tersebut dapat dilihat bahwa untuk seluruh pemodelan 

struktur baik tanpa outrigger, eksisting maupun struktur dengan variasi pemindahan 

outrigger mengalami kenaikan nilai story drift yang sangat besar pada arah X serta 

arah Y pada lantai 4. Besarnya kenaikan nilai story drift pada lantai tersebut dapat 

disebabkan oleh beberapa faktor salah satunya perbedaan tinggi lantai antar tingkat. 

Dimana pada lantai ini terdapat perbedaan tinggi lantai dengan lantai sebelumnya 

dan pengecilan dimensi kolom. Perbedaan tinggi lantai dan pengecilan dimensi 

kolom dapat menyebabkan perubahan kekakuan pada kolom. Kekakuan kolom 
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lantai yang lebih tinggi dari kekakuan kolom lantai sebelumnya atau kondisi ini 

biasa disebut soft story yang menyebabkan kenaikan nilai story drift yang besar 

seperti pada grafik tersebut. Oleh karena itu, bangunan ini memiliki 

ketidakberaturan tingkat lunak atau soft story. Dari gambar 4.10 juga terlihat bahwa 

pada lantai 14 dan 26 juga terjadi kenaikan story drift yang besar. Seperti lantai 4, 

lantai 14 dan 26 merupakan soft story. Selain itu lantai 7 dan 8 juga merupakan soft 

story. 
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Sumber: Data Hasil Penelitian 

Gambar 4. 10 Nilai Story Drift Pada Arah X 
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Sumber: Data Hasil Penelitian 

Gambar 4. 11 Nilai Story Drift Pada Arah Y 

4.3      Analisa Keseluruhan 

 Berdasarkan hasil penelitian dan pembahasan parameter-parameter respon 

struktur pada semua pemodelan menunjukkan bahwa adanya sistem outrigger 
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dapat mempengaruhi respon struktur terhadap beban gempa.  Hal ini dapat terlihat 

dari perbedaan parameter uji yang terjadi pada setiap pemodelan. 

Berdasarkan analisa pada seluruh pemodelan, penempatan outrigger pada 

bangunan dapat merubah perilaku bangunan. Parameter nilai base shear harusnya 

meningkat setelah adanya outrigger sebagai sistem tambahan penahan gaya lateral. 

Dimana semakin besar nilai base shear maka semakin baik kinerja bangunan dalam 

menahan gaya gempa. Hal ini ditunjukkan oleh penempatan outrigger pada 3/4h 

(variasi 2) yang mempunyai nilai base shear yang lebih besar dan nilai story drift 

yang kecil daripada pemodelan tanpa outrigger dengan penempatan outrigger pada 

lantai yang tipikal dengan lantai disekitarnya.  Namun pada pemodelan struktur 

penempatan outrigger pada 1/4h (variasi 1), penempatan outrigger pada 1/2h 

(eksisting) dan penempatan outrigger pada atap (variasi 3) nilai base shear 

diketahui bahwa nilai base shear yang menggunakan outrigger justru mengalami 

penurunan.  

Penurunan nilai base shear dapat dipengaruhi beberapa faktor seperti massa 

dan periode struktur. Penambahan outrigger pada pemodelan variasi 1 dan eksisting 

di lantai yang mengalami soft story menyebabkan adanya ketidakberaturan massa 

karena banyaknya balok outrigger yang bermaterial beton. Penambahan massa 

pada lantai yang kekakuannya berkurang mengakibatkan membesarnya nilai 

periode yang juga menyebabkan menurunnya nilai base shear.  

Sedangkan pada variasi 3 penempatan outrigger pada lantai atap juga 

menyebabkan menurunnya nilai base shear. Hal ini disebabkan karena adanya 

outrigger pada lantai atap dengan massa yang sehingga mengakibatkan periode 
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yang meningkat. Dalam perencaanaan struktur bangunan semakin keatas struktur 

bangunan akan dibuat semakin ringan. 

Dari analisa nilai displacement seluruh pemodelan dapat disimpulkan 

bahwa adanya outrigger sebagai sistem tambahan penahan gaya lateral dapat 

mereduksi nilai displacement maksimum pada struktur. Penurunan displacement 

terbesar terjadi pada penempatan outrigger 3/4h bangunan sebesar 15,08% arah X 

dan 8,2%1 arah Y. Nilai Rata-rata nilai displacement maksimum dari semua 

pemodelan yang direduksi adalah 4,6%.   

Sementara nilai story drift berbanding lurus dengan displacement, semakin 

besar displacement maka akan semakin besar pula nilai story drift atau simpangan 

antar tingkat. Penempatan outrigger pada 3/4h menujukkan outrigger dapat 

berfungsi optimal sebagai sistem yang meminimalisir nilai story drift. Sedangkan 

penempatan outrigger pada 1/4h dan 1/2h yang merupakan soft story tidak 

berfungsi optimal meminimalisir story drift. Hal ini terjadi karena penempatan 

outrigger pada soft story akan menyebabkan outrigger berfungsi memperbaiki 

kekakuan akibat soft story itu sendiri. Namun, nilai displacement maksimum dan 

story drift pada semua pemodelan masih dalam batas aman setelah dibandingkan 

dengan kontrol batas maksimum. 

Berdasarkan hasil analisa keseluruhan terlihat bahwa dampak dari 

penggunaan outrigger sangat dipengaruhi oleh penempatan outrigger pada 

bangunan dan massa outrigger tersebut. Dalam hal ini letak penempatan outrigger 

sangat mempengaruhi perilaku struktur bangunan saat menahan beban gempa. 
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4.4    Keterbatasan Penelitian 

1.        Pada pemodelan eksisting masih terdapat komponen-komponen struktur yang 

overstress. 

2.     Perbedaan massa outrigger pada variasi 1 dan eksisting dengan variasi 2 dan 

3 disebabkan adanya perbedaan tinggi lantai antar tingkat sehingga panjang 

outrigger mengikuti tinggi lantai penempatan outrigger. 
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BAB V 

KESIMPULAN DAN SARAN 

5.1 Kesimpulan 

Setelah melakukan penelitian dan analisa data mengenai respon bangunan 

tinggi yang menggunakan outrigger pada proyek ST. Morits Panakukang dan 

beberapa variasi pemindahan outrigger pada pemodelan struktur maka dapat 

disimpulkan bahwa: 

1. Penambahan sistem outrigger pada bangunan tinggi yang mempunyai 

ketidakberaturan lantai lunak dan ketidakberaturan massa dapat 

mempengaruhi perilaku bangunan terhadap beban gempa. Penempatan 

outrigger pada 1/4h dan 1/2h yang merupakan soft story menyebabkan 

adanya ketidakberaturan massa. Ketidakberaturan massa pada lantai lunak 

mengakibatkan mengecilnya nilai base shear, besarnya periode bangunan, 

besarnya nilai displacement serta story drift. Penempatan outrigger pada 

1/4h dan 1/2h yang merupakan soft story tidak berfungsi optimal 

meminimalisir story drift. Hal ini terjadi karena penempatan outrigger pada 

soft story akan menyebabkan outrigger berfungsi memperbaiki kekakuan 

akibat soft story itu sendiri. 

2. Nilai displacement maksimum dan story drift dari seluruh variasi masih 

dalam batas aman berdasarkan SNI 1726 2012. 

3. Variasi 2 merupakan pemodelan yang menggunakan outrigger pada ¾ h 

bangunan menunjukkan perilaku yang paling baik setelah ditinjau dari nilai 

base shear, displacement maksimum dan story drift.  
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4. Jika mempertimbangan keefektifan, penggunaan sistem outrigger yang 

digunakan sebagai sistem penahan gaya lateral tambahan pada St. Morits 

Panakkukang tidak perlu digunakan mengingat adanya outrigger hanya 

mereduksi nilai displacement 5,95% pada arah X dan 2,84% pada arah Y. 

Hal ini terjadi karena bangunan yang sudah kaku yang dapat dilihat dari 

konfigurasi core wall dan shear wall pada struktur bangunan ini. 

5.2 Saran 

Berdasarkan hasil penelitian, agar dapat melakukan penelitian serupa 

dengan lebih baik maka disarankan: 

1. Membuat pemodelan struktur dengan teliti sesuai gambar kerja dan 

pembebanan struktur sesuai fungsi ruang sehingga hasil analisa yang 

didapatkan mewakili bangunan eksisting. 

2. Memberikan perlakuan yang sama pada setiap variasi pemodelan dengan 

agar lebih mudah untuk dibandingkan satu sama lain. 
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Lampiran 1. Evaluasi Nilai Base Shear dan Perhitungan Faktor Skala 

Terkoreksi 

a. Tanpa Outrigger 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝐼 )

× 𝑊𝑡 =
0,157

0,5491 (
8
1)

× 515785,666 = 18434,3356 𝑘𝑁 

0,85𝑉1 = 0,85.18434,666 = 15669,1853 𝑘𝑁 

𝑉 ≥ 0,85 𝑉1 

• Arah X : 1617,03 𝑘𝑁 ≥ 15669,1853 𝑘𝑁...................TIDAK OKE 

• Arah Y : 1282,44 𝑘𝑁 ≥ 15669,1853 𝑘𝑁...................TIDAK OKE 

Nilai base shear hasil run analysis pada arah X maupun arah Y tidak 

melebihi nilai base shear yang dihitung maka faktor skala perlu dikoreksi. Faktor 

skala awal dikoreksi untuk kasus RSPX dan kasus RSPY melalui perhitungan di 

bawah ini. 

Kasus RSPX 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18434,3356)

1617,03
× 1,2263 = 11.8830 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18434,3356)

1617,03
× 0,3675 = 3.5649 

Kasus RSPY 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18434,3356)

1282,44
× 0,3675 = 4.4950 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18434,3356)

1282,44
× 1,2263 = 14.9833 
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b. Variasi 1 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝐼 )

× 𝑊𝑡 =
0,157

0,5794 (
8
1)

× 533446,824 = 18068,51 𝑘𝑁 

0,85𝑉1 = 0,85.18068,51 = 15358,232 𝑘𝑁 

𝑉 ≥ 0,85 𝑉1 

• Arah X : 1580,81 𝑘𝑁 ≥ 15358,232 𝑘𝑁.....................TIDAK OKE 

• Arah Y : 1224,59 𝑘𝑁 ≥ 15358,232 𝑘𝑁.....................TIDAK OKE 

Nilai base shear hasil run analysis pada arah X maupun arah Y tidak 

memenuhi nilai base shear yang dihitung maka faktor skala perlu dikoreksi. Faktor 

skala awal dikoreksi melalui perhitungan di bawah ini. 

Kasus RSPX 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18068,51)

1580,81
× 1,2263 = 11.9140 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18068,51)

1580,81
× 0,3675 = 3.5742 

Kasus RSPY 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18068,51)

1224,59
× 0,3675 = 4.6139 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18068,51)

1224,59
× 1,2263 = 15.3797 

c. Eksisting 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝐼 )

× 𝑊𝑡 =
0,157

0,5738 (
8
1)

× 533446,824 = 18244,82 𝑘𝑁 

0,85𝑉1 = 0,85.18244,82 = 15669,1853 𝑘𝑁 
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𝑉 ≥ 0,85 𝑉1 

• Arah X : 1699,25 𝑘𝑁 ≥ 15508,12 𝑘𝑁.......................TIDAK OKE 

• Arah Y : 1411,32 𝑘𝑁 ≥ 15508,12 𝑘𝑁.......................TIDAK OKE 

Nilai base shear hasil run analysis pada arah X maupun arah Y tidak 

memenuhi nilai base shear yang dihitung maka faktor skala perlu dikoreksi. Faktor 

skala awal dikoreksi melalui perhitungan di bawah ini. 

Kasus RSPX 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18244,82)

1699,25
× 1,2263 = 11.1918 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18244,82)

1699,25
× 0,3675 = 3.3575 

Kasus RSPY 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18244,82)

1411,32
× 0,3675 = 4.0425 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18244,82)

1411,32
× 1,2263 = 13.4751 

d. Variasi 2 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝐼 )

× 𝑊𝑡 =
0,157

0,5490 (
8
1)

× 530922,275 = 18978,77 𝑘𝑁 

0,85𝑉1 = 0,85.18978,77 = 16131,96 𝑘𝑁 

𝑉 ≥ 0,85 𝑉1 

• Arah X : 1659,42 𝑘𝑁 ≥ 16131,96 𝑘𝑁.......................TIDAK OKE 

• Arah Y : 1315,06 𝑘𝑁 ≥ 16131,96 𝑘𝑁.......................TIDAK OKE 
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Nilai base shear hasil run analysis pada arah X maupun arah Y tidak 

memenuhi nilai base shear yang dihitung maka faktor skala perlu dikoreksi. Faktor 

skala awal dikoreksi melalui perhitungan di bawah ini. 

Kasus RSPX 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18978,77 )

1659,42
× 1,2263 = 11.9214 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18978,77 )

1659,42
× 0,3675 = 3.5764 

Kasus RSPY 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18978,77 )

1315,06
× 0,3675 = 4.5129 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(18978,77 )

1315,06
× 1,2263 = 15.0431 

e. Variasi 3 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝐼 )

× 𝑊𝑡 =
0,157

0,5924 (
8
1)

× 530922,275 = 17588,36 𝑘𝑁 

0,85𝑉1 = 0,85.17588,36 = 14950,11 𝑘𝑁 

𝑉 ≥ 0,85 𝑉1 

• Arah X : 1824,96 𝑘𝑁 ≥ 14950,11 𝑘𝑁.......................TIDAK OKE 

• Arah Y : 1461,83𝑘𝑁 ≥ 14950,11 𝑘𝑁........................TIDAK OKE 

Nilai base shear hasil run analysis pada arah X maupun arah Y tidak 

memenuhi nilai base shear yang dihitung maka faktor skala perlu dikoreksi. Faktor 

skala awal dikoreksi melalui perhitungan di bawah ini. 
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Kasus RSPX 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(17588,36)

1824,96
× 1,2263 = 10.0459 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(17588,36)

1824,96
× 0,3675 = 3.0138 

Kasus RSPY 

∎ 𝑈1 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(17588,36)

1461,83
× 0,3675 = 3.7624 

∎ 𝑈2 =
0,85𝑉1

𝑉
× 1,2263 =

0,85(17588,36)

1461,83
× 1,2263 = 12.5414 
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Lampiran 2. Nilai Displacement  

• Arah X 

Lantai 

Displacement Arah X (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 17.4777 17.1712 16.4967 15.1871 17.1148 

Lantai 49 16.4165 16.2203 15.6331 14.6673 16.2957 

Lantai 48 15.3472 15.2107 14.6113 14.0067 14.5306 

Lantai 47 13.9575 13.8883 13.2529 13.1127 12.0287 

Lantai 46 12.4952 12.4945 11.7961 12.1808 10.7359 

Lantai 45 11.0485 11.1178 10.3329 11.2843 9.2195 

Lantai 44 9.6844 9.8262 8.9343 10.4812 7.7042 

Lantai 43 8.4489 8.6673 7.6492 9.8013 6.3099 

Lantai 42 7.3537 7.6541 6.4928 9.2262 5.0876 

Lantai 41 6.5176 6.892 5.5453 8.7423 4.1341 

Lantai 40 5.6817 6.1579 4.7123 8.1893 3.3153 

Lantai 39 5.1158 5.6984 4.1532 7.6352 2.7263 

Lantai 38 4.7098 5.3886 3.696 7.4282 2.3193 

Lantai 37 4.4015 5.1709 3.3585 8.2806 2.1467 

Lantai 36 4.1938 5.0447 3.1665 7.8701 2.1521 

Lantai 35 4.0923 5.0111 3.1463 7.7176 2.2681 

Lantai 34 4.104 5.0722 3.3102 6.7757 2.4794 

Lantai 33 4.236 5.2318 3.6554 6.882 2.7773 

Lantai 32 4.436 5.443 4.1363 7.1863 3.1163 

Lantai 31 4.8236 5.801 4.7958 7.4495 3.5732 

Lantai 30 5.2539 6.183 5.5498 7.6168 4.0519 

Lantai 29 5.7691 6.6253 6.4354 7.7376 4.5856 

Lantai 28 6.372 7.1305 7.4723 7.8649 5.1771 

Lantai 27 7.0751 7.7122 8.7016 8.0598 5.8414 
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Lantai 26 7.8713 8.3613 10.1451 8.3473 6.5747 

Lantai 25 8.7821 9.0987 11.832 8.7619 7.3951 

Lantai 24 9.8744 9.9894 13.7425 9.3689 8.3658 

Lantai 23 11.0873 10.9766 15.4419 10.133 9.4527 

Lantai 22 12.9213 12.4025 16.6777 11.3333 11.1297 

Lantai 21 14.316 13.3706 17.0453 12.1992 12.3733 

Lantai 20 14.8801 13.7241 17.2323 12.5632 12.8773 

Lantai 19 15.2562 13.9467 17.1098 12.8136 13.2136 

Lantai 18 15.5213 14.1351 16.5739 12.9943 13.447 

Lantai 17 15.7076 14.3483 15.9242 13.1248 13.6079 

Lantai 16 15.8306 14.6303 15.2823 13.2151 13.7125 

Lantai 15 15.9007 15.0175 14.6899 13.2711 13.7714 

Lantai 14 15.9258 15.5387 14.1512 13.2969 13.7925 

Lantai 13 15.9154 16.2014 13.6531 13.2985 13.7852 

Lantai 12 15.8844 16.9343 13.1666 13.2842 13.7632 

Lantai 11 15.8269 17.4608 12.6924 13.2458 13.724 

Lantai 10 15.2332 18.6122 11.7615 12.7805 13.2361 

Lantai 9 14.3797 18.2459 10.7959 12.0996 12.5184 

Lantai 8 13.7174 17.5715 10.1367 11.5732 11.9554 

Lantai 7 12.958 16.9119 9.4381 10.9695 11.3042 

Lantai 6 12.1136 15.7641 8.701 10.2937 10.5763 

Lantai 5 11.1808 14.3756 7.9191 9.539 9.7696 

Lantai 4 9.9284 12.5283 6.9149 8.5158 8.6858 

Lantai 3 8.1712 10.0326 5.5602 7.0671 7.1648 

Lantai 2 6.3797 7.5771 4.2581 5.5699 5.611 

Lantai 1 4.3861 5.1144 2.8798 3.8627 3.865 

Lantai UG 2.2376 2.6902 1.482 1.94 1.9905 

Lantai GF 0.3008 0.3705 0.2367 0.2769 0.2857 

Lantai LG 0.0538 0.0736 0.039 0.0475 0.0482 

Basement 0.0596 0.0626 0.0545 0.0571 0.0587 



99 

 

 

 

• Arah Y 

Lantai 

Displacement Arah Y (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 36.5834 36.2874 35.5731 33.8085 34.1801 

Lantai 49 34.0052 33.7543 32.9301 31.6148 32.632 

Lantai 48 30.9852 30.8087 29.8569 29.2533 28.8333 

Lantai 47 27.7459 27.6635 26.5636 26.8873 24.6337 

Lantai 46 24.5268 24.553 23.2861 24.6982 20.7347 

Lantai 45 21.4819 21.6289 20.1747 22.8021 17.2377 

Lantai 44 18.7036 18.9827 17.317 21.2573 14.1394 

Lantai 43 16.2445 16.6666 14.7614 20.0623 11.4455 

Lantai 42 14.1302 14.7066 12.5304 19.1354 9.1749 

Lantai 41 12.3602 13.1026 10.6258 18.2553 7.3396 

Lantai 40 10.908 11.8207 9.033 17.074 5.9381 

Lantai 39 9.6985 10.7855 7.6878 15.2121 5.0905 

Lantai 38 8.7347 9.9952 6.6117 14.4894 4.5041 

Lantai 37 8.0129 9.4397 5.95 17.4984 4.189 

Lantai 36 7.5828 9.1793 5.5789 17.9571 4.1342 

Lantai 35 7.3882 9.1084 5.5441 17.8352 4.3072 

Lantai 34 7.4103 9.2174 5.8668 17.242 4.6707 

Lantai 33 7.6569 9.5068 6.5301 16.7081 5.1978 

Lantai 32 8.1354 9.9788 7.5091 16.325 5.8791 

Lantai 31 8.8085 10.5948 8.8355 16.0207 6.6812 

Lantai 30 9.6596 11.3389 10.3802 15.7706 7.5985 

Lantai 29 10.6751 12.1979 12.1285 15.6058 8.6259 

Lantai 28 11.8457 13.1632 14.0669 15.5764 9.7613 

Lantai 27 13.1673 14.2834 16.21 15.7325 11.0056 

Lantai 26 14.6571 15.5386 18.6112 16.1304 12.3768 
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Lantai 25 16.3203 16.9285 21.3155 16.7945 13.8941 

Lantai 24 18.1333 18.4472 24.2825 17.7033 15.5509 

Lantai 23 20.015 20.0323 27.1398 18.7602 17.2866 

Lantai 22 23.1995 22.5725 30.3367 20.5359 20.1303 

Lantai 21 25.7558 24.5247 30.5625 21.9286 22.3995 

Lantai 20 26.7699 25.2863 29.9618 22.4552 23.2825 

Lantai 19 27.5229 25.8959 29.421 22.8573 23.9257 

Lantai 18 28.0979 26.4669 28.7344 23.1695 24.4106 

Lantai 17 28.5333 27.068 28.081 23.5196 24.7743 

Lantai 16 28.845 27.7413 27.377 23.8065 25.0324 

Lantai 15 29.042 28.5119 26.6351 23.9986 25.1933 

Lantai 14 29.1294 29.3871 25.872 24.0985 25.2621 

Lantai 13 29.1068 30.3426 25.0966 24.1057 25.2388 

Lantai 12 28.9614 31.2998 24.3007 24.0123 25.114 

Lantai 11 28.6541 32.1076 23.4458 23.7919 24.8565 

Lantai 10 27.6376 32.6893 21.7728 23.0245 24.0099 

Lantai 9 26.1362 32.3454 19.9706 21.8337 22.7434 

Lantai 8 24.9818 30.9426 18.7558 20.8924 21.7582 

Lantai 7 23.7451 29.3084 17.5378 19.8739 20.698 

Lantai 6 22.4546 27.332 16.3343 18.81 19.591 

Lantai 5 21.1026 25.2291 15.1406 17.6997 18.4325 

Lantai 4 19.2536 22.7513 13.6034 16.1856 16.8468 

Lantai 3 16.1243 18.7865 11.1374 13.5897 14.1306 

Lantai 2 12.461 14.5971 8.3793 10.4992 10.9123 

Lantai 1 8.6044 10.1488 5.6605 7.2459 7.5297 

Lantai UG 4.5615 5.2712 2.9705 3.8459 3.9949 

Lantai GF 0.2234 0.2541 0.1402 0.1868 0.1942 

Lantai LG 0.0957 0.1052 0.077 0.0843 0.089 

Basement 0.0246 0.0238 0.0231 0.0214 0.0243 
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Lampiran 3. Nilai Story Drift  

• Arah X 

Lantai 

Story Drift Arah X (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 1.0612 0.9509 0.8636 0.5198 0.4491 

Lantai 49 1.0693 1.0096 1.0218 0.6606 5.2667 

Lantai 48 1.3897 1.3224 1.3584 0.894 2.5019 

Lantai 47 1.4623 1.3938 1.4568 0.9319 1.2928 

Lantai 46 1.4467 1.3767 1.4632 0.8965 1.5164 

Lantai 45 1.3641 1.2916 1.3986 0.8031 1.5153 

Lantai 44 1.2355 1.1589 1.2851 0.6799 1.3943 

Lantai 43 1.0952 1.0132 1.1564 0.5751 1.2223 

Lantai 42 0.8361 0.7621 0.9475 0.4839 0.9535 

Lantai 41 0.8359 0.7341 0.833 0.553 0.8188 

Lantai 40 0.5659 0.4595 0.5591 0.5541 0.589 

Lantai 39 0.406 0.3098 0.4572 0.207 0.407 

Lantai 38 0.3083 0.2177 0.3375 0.8524 0.1726 

Lantai 37 0.2077 0.1262 0.192 0.4105 0.0054 

Lantai 36 0.1015 0.0336 0.0202 0.1525 0.116 

Lantai 35 0.0117 0.0611 0.1639 0.9419 0.2113 

Lantai 34 0.132 0.1596 0.3452 0.1063 0.2979 

Lantai 33 0.2 0.2112 0.4809 0.3043 0.339 

Lantai 32 0.3876 0.358 0.6595 0.2632 0.4569 

Lantai 31 0.4303 0.382 0.754 0.1673 0.4787 

Lantai 30 0.5152 0.4423 0.8856 0.1208 0.5337 

Lantai 29 0.6029 0.5052 1.0369 0.1273 0.5915 

Lantai 28 0.7031 0.5817 1.2293 0.1949 0.6643 

Lantai 27 0.7962 0.6491 1.4435 0.2875 0.7333 
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Lantai 26 0.9108 0.7374 1.6869 0.4146 0.8204 

Lantai 25 1.0923 0.8907 1.9105 0.607 0.9707 

Lantai 24 1.2129 0.9872 1.6994 0.7641 1.0869 

Lantai 23 1.834 1.4259 1.2358 1.2003 1.677 

Lantai 22 1.3947 0.9681 0.3676 0.8659 1.2436 

Lantai 21 0.5641 0.3535 0.187 0.364 0.504 

Lantai 20 0.3761 0.2226 0.1225 0.2504 0.3363 

Lantai 19 0.2651 0.1884 0.5359 0.1807 0.2334 

Lantai 18 0.1863 0.2132 0.6497 0.1305 0.1609 

Lantai 17 0.123 0.282 0.6419 0.0903 0.1046 

Lantai 16 0.0701 0.3872 0.5924 0.056 0.0589 

Lantai 15 0.0251 0.5212 0.5387 0.0258 0.0211 

Lantai 14 0.0104 0.6627 0.4981 0.0016 0.0073 

Lantai 13 0.031 0.7329 0.4865 0.0143 0.022 

Lantai 12 0.0575 0.5265 0.4742 0.0384 0.0392 

Lantai 11 0.5937 1.1514 0.9309 0.4653 0.4879 

Lantai 10 0.8535 0.3663 0.9656 0.6809 0.7177 

Lantai 9 0.6623 0.6744 0.6592 0.5264 0.563 

Lantai 8 0.7594 0.6596 0.6986 0.6037 0.6512 

Lantai 7 0.8444 1.1478 0.7371 0.6758 0.7279 

Lantai 6 0.9328 1.3885 0.7819 0.7547 0.8067 

Lantai 5 1.2524 1.8473 1.0042 1.0232 1.0838 

Lantai 4 1.7572 2.4957 1.3547 1.4487 1.521 

Lantai 3 1.7915 2.4555 1.3021 1.4972 1.5538 

Lantai 2 1.9936 2.4627 1.3783 1.7072 1.746 

Lantai 1 2.1485 2.4242 1.3978 1.9227 1.8745 

Lantai UG 1.9368 2.3197 1.2453 1.6631 1.7048 

Lantai GF 0.247 0.2969 0.1977 0.2294 0.2375 

Lantai LG 0.0058 0.011 0.0155 0.0096 0.0105 

Basement 0.0000 0.0000 0.0000 0.0000 0.0000 
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• Arah Y 

Lantai 

Story Drift Arah Y (mm) 

Tanpa 

Outrigger 
Variasi 1 Eksisting Variasi 2 Variasi 3 

ATAP 2.5782 2.5331 2.643 2.1937 1.5481 

Lantai 49 3.02 2.9456 3.0732 2.3615 3.7987 

Lantai 48 3.2393 3.1452 3.2933 2.366 4.1996 

Lantai 47 3.2191 3.1105 3.2775 2.1891 3.899 

Lantai 46 3.0449 2.9241 3.1114 1.8961 3.497 

Lantai 45 2.7783 2.6462 2.8577 1.5448 3.0983 

Lantai 44 2.4591 2.3161 2.5556 1.195 2.6939 

Lantai 43 2.1143 1.96 2.231 0.9269 2.2706 

Lantai 42 1.77 1.604 1.9046 0.8801 1.8353 

Lantai 41 1.4522 1.2819 1.5928 1.1813 1.4015 

Lantai 40 1.2095 1.0352 1.3452 1.8619 0.8476 

Lantai 39 0.9638 0.7903 1.0761 0.7227 0.5864 

Lantai 38 0.7218 0.5555 0.6617 3.009 0.3151 

Lantai 37 0.4301 0.2604 0.3711 0.4587 0.0548 

Lantai 36 0.1946 0.0709 0.0348 0.1219 0.173 

Lantai 35 0.0221 0.109 0.3227 0.5932 0.3635 

Lantai 34 0.2466 0.2894 0.6633 0.5339 0.5271 

Lantai 33 0.4785 0.472 0.979 0.3831 0.6813 

Lantai 32 0.6731 0.616 1.3264 0.3043 0.8021 

Lantai 31 0.8511 0.7441 1.5447 0.2501 0.9173 

Lantai 30 1.0155 0.859 1.7483 0.1648 1.0274 

Lantai 29 1.1706 0.9653 1.9384 0.0294 1.1354 

Lantai 28 1.3216 1.1202 2.1431 0.1561 1.2443 

Lantai 27 1.4898 1.2552 2.4012 0.3979 1.3712 

Lantai 26 1.6632 1.3899 2.7043 0.6641 1.5173 
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Lantai 25 1.813 1.5187 2.967 0.9088 1.6568 

Lantai 24 1.8817 1.5851 2.8573 1.0569 1.7357 

Lantai 23 3.1845 2.5402 3.1969 1.7757 2.8437 

Lantai 22 2.5563 1.9522 0.2258 1.3927 2.2692 

Lantai 21 1.0141 0.7616 0.6007 0.5266 0.883 

Lantai 20 0.753 0.6096 0.5408 0.4021 0.6432 

Lantai 19 0.575 0.571 0.6866 0.3122 0.4849 

Lantai 18 0.4354 0.6011 0.6534 0.3501 0.3637 

Lantai 17 0.3117 0.6733 0.704 0.2869 0.2581 

Lantai 16 0.197 0.7706 0.7419 0.1921 0.1609 

Lantai 15 0.0874 0.8752 0.7631 0.0999 0.0688 

Lantai 14 0.0226 0.9555 0.7754 0.0072 0.0233 

Lantai 13 0.1454 0.9572 0.7959 0.0934 0.1248 

Lantai 12 0.3073 0.8078 0.8549 0.2204 0.2575 

Lantai 11 1.0165 0.5817 1.673 0.7674 0.8466 

Lantai 10 1.5014 0.3439 1.8022 1.1908 1.2665 

Lantai 9 1.1544 1.4028 1.2148 0.9413 0.9852 

Lantai 8 1.2367 1.6342 1.218 1.0185 1.0602 

Lantai 7 1.2905 1.9764 1.2035 1.0639 1.107 

Lantai 6 1.352 2.1029 1.1937 1.1103 1.1585 

Lantai 5 1.849 2.4778 1.5372 1.5141 1.5857 

Lantai 4 3.1293 3.9648 2.466 2.5959 2.7162 

Lantai 3 3.6633 4.1894 2.7581 3.0905 3.2183 

Lantai 2 3.8566 4.4483 2.7188 3.2533 3.3826 

Lantai 1 4.0429 4.8776 2.69 3.4 3.5348 

Lantai UG 4.3381 5.0171 2.8303 3.6591 3.8007 

Lantai GF 0.1277 0.1489 0.0632 0.1025 0.1052 

Lantai LG 0.0711 0.0814 0.0539 0.0629 0.0647 

Basement 0.0000 0.0000 0.0000 0.0000 0.0000 
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Lampiran 4. Kontrol Story Drift 

• Pada Arah X 

Lantai 

Story Drift Arah X (mm) 
Tinggi 

lantai  
Batas 

Aman Ket. Tanpa 

Outrigger 

Variasi 

1 
Eksisting 

Variasi 

2 

Variasi 

3 
h (mm) 

0,02h 

(mm) 

ATAP 1.0612 0.9509 0.8636 0.5198 0.4491 3200 64 Aman 

Lt. 49 1.0693 1.0096 1.0218 0.6606 5.2667 3200 64 Aman 

Lt. 48 1.3897 1.3224 1.3584 0.894 2.5019 3200 64 Aman 

Lt. 47 1.4623 1.3938 1.4568 0.9319 1.2928 3200 64 Aman 

Lt. 46 1.4467 1.3767 1.4632 0.8965 1.5164 3200 64 Aman 

Lt.  45 1.3641 1.2916 1.3986 0.8031 1.5153 3200 64 Aman 

Lt. 44 1.2355 1.1589 1.2851 0.6799 1.3943 3200 64 Aman 

Lt. 43 1.0952 1.0132 1.1564 0.5751 1.2223 3200 64 Aman 

Lt. 42 0.8361 0.7621 0.9475 0.4839 0.9535 3200 64 Aman 

Lt. 41 0.8359 0.7341 0.833 0.553 0.8188 3200 64 Aman 

Lt. 40 0.5659 0.4595 0.5591 0.5541 0.589 3200 64 Aman 

Lt. 39 0.406 0.3098 0.4572 0.207 0.407 3200 64 Aman 

Lt. 38 0.3083 0.2177 0.3375 0.8524 0.1726 3200 64 Aman 

Lt. 37 0.2077 0.1262 0.192 0.4105 0.0054 3200 64 Aman 

Lt. 36 0.1015 0.0336 0.0202 0.1525 0.116 3200 64 Aman 

Lt. 35 0.0117 0.0611 0.1639 0.9419 0.2113 3200 64 Aman 

Lt. 34 0.132 0.1596 0.3452 0.1063 0.2979 3200 64 Aman 

Lt. 33 0.2 0.2112 0.4809 0.3043 0.339 3200 64 Aman 

Lt. 32 0.3876 0.358 0.6595 0.2632 0.4569 3200 64 Aman 

Lt. 31 0.4303 0.382 0.754 0.1673 0.4787 3200 64 Aman 

Lt. 30 0.5152 0.4423 0.8856 0.1208 0.5337 3200 64 Aman 

Lt. 29 0.6029 0.5052 1.0369 0.1273 0.5915 3200 64 Aman 

Lt. 28 0.7031 0.5817 1.2293 0.1949 0.6643 3200 64 Aman 

Lt. 27 0.7962 0.6491 1.4435 0.2875 0.7333 3200 64 Aman 
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Lt. 26 0.9108 0.7374 1.6869 0.4146 0.8204 3200 64 Aman 

Lt. 25 1.0923 0.8907 1.9105 0.607 0.9707 3200 64 Aman 

Lt. 24 1.2129 0.9872 1.6994 0.7641 1.0869 3200 64 Aman 

Lt. 23 1.834 1.4259 1.2358 1.2003 1.677 5600 112 Aman 

Lt. 22 1.3947 0.9681 0.3676 0.8659 1.2436 6000 120 Aman 

Lt. 21 0.5641 0.3535 0.187 0.364 0.504 3500 70 Aman 

Lt. 20 0.3761 0.2226 0.1225 0.2504 0.3363 3500 70 Aman 

Lt. 19 0.2651 0.1884 0.5359 0.1807 0.2334 3500 70 Aman 

Lt. 18 0.1863 0.2132 0.6497 0.1305 0.1609 3500 70 Aman 

Lt. 17 0.123 0.282 0.6419 0.0903 0.1046 3500 70 Aman 

Lt. 16 0.0701 0.3872 0.5924 0.056 0.0589 3500 70 Aman 

Lt. 15 0.0251 0.5212 0.5387 0.0258 0.0211 3500 70 Aman 

Lt. 14 0.0104 0.6627 0.4981 0.0016 0.0073 3500 70 Aman 

Lt. 13 0.031 0.7329 0.4865 0.0143 0.022 3500 70 Aman 

Lt. 12 0.0575 0.5265 0.4742 0.0384 0.0392 3500 70 Aman 

Lt. 11 0.5937 1.1514 0.9309 0.4653 0.4879 5600 112 Aman 

Lt. 10 0.8535 0.3663 0.9656 0.6809 0.7177 5000 100 Aman 

Lt. 9 0.6623 0.6744 0.6592 0.5264 0.563 3250 65 Aman 

Lt. 8 0.7594 0.6596 0.6986 0.6037 0.6512 3250 65 Aman 

Lt. 7 0.8444 1.1478 0.7371 0.6758 0.7279 3250 65 Aman 

Lt. 6 0.9328 1.3885 0.7819 0.7547 0.8067 3250 65 Aman 

Lt. 5 1.2524 1.8473 1.0042 1.0232 1.0838 4000 80 Aman 

Lt. 4 1.7572 2.4957 1.3547 1.4487 1.521 5500 110 Aman 

Lt. 3 1.7915 2.4555 1.3021 1.4972 1.5538 5500 110 Aman 

Lt. 2 1.9936 2.4627 1.3783 1.7072 1.746 5500 110 Aman 

Lt. 1 2.1485 2.4242 1.3978 1.9227 1.8745 5500 110 Aman 

Lt. UG 1.9368 2.3197 1.2453 1.6631 1.7048 7000 140 Aman 

Lt. GF 0.247 0.2969 0.1977 0.2294 0.2375 7000 140 Aman 

Lt. LG 0.0058 0.011 0.0155 0.0096 0.0105 3250 65 Aman 

Base 1 0.0000 0.0000 0.0000 0.0000 0.0000 3250 65 Aman 
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• Pada Arah Y 

Lantai 

Story Drift Arah Y (mm) 
Tinggi 

lantai  
Batas 

Aman 
Ket. Tanpa 

Outrigger 

Variasi 

1 
Eksisting 

Variasi 

2 

Variasi 

3 h 

(mm) 
0,02h 

(mm) 

ATAP 2.5782 2.5331 2.643 2.1937 1.5481 3200 64 Aman 

Lt. 49 3.02 2.9456 3.0732 2.3615 3.7987 3200 64 Aman 

Lt. 48 3.2393 3.1452 3.2933 2.366 4.1996 3200 64 Aman 

Lt. 47 3.2191 3.1105 3.2775 2.1891 3.899 3200 64 Aman 

Lt. 46 3.0449 2.9241 3.1114 1.8961 3.497 3200 64 Aman 

Lt. 45 2.7783 2.6462 2.8577 1.5448 3.0983 3200 64 Aman 

Lt. 44 2.4591 2.3161 2.5556 1.195 2.6939 3200 64 Aman 

Lt. 43 2.1143 1.96 2.231 0.9269 2.2706 3200 64 Aman 

Lt. 42 1.77 1.604 1.9046 0.8801 1.8353 3200 64 Aman 

Lt. 41 1.4522 1.2819 1.5928 1.1813 1.4015 3200 64 Aman 

Lt. 40 1.2095 1.0352 1.3452 1.8619 0.8476 3200 64 Aman 

Lt. 39 0.9638 0.7903 1.0761 0.7227 0.5864 3200 64 Aman 

Lt. 38 0.7218 0.5555 0.6617 3.009 0.3151 3200 64 Aman 

Lt. 37 0.4301 0.2604 0.3711 0.4587 0.0548 3200 64 Aman 

Lt. 36 0.1946 0.0709 0.0348 0.1219 0.173 3200 64 Aman 

Lt. 35 0.0221 0.109 0.3227 0.5932 0.3635 3200 64 Aman 

Lt. 34 0.2466 0.2894 0.6633 0.5339 0.5271 3200 64 Aman 

Lt. 33 0.4785 0.472 0.979 0.3831 0.6813 3200 64 Aman 

Lt. 32 0.6731 0.616 1.3264 0.3043 0.8021 3200 64 Aman 

Lt. 31 0.8511 0.7441 1.5447 0.2501 0.9173 3200 64 Aman 

Lt. 30 1.0155 0.859 1.7483 0.1648 1.0274 3200 64 Aman 

Lt. 29 1.1706 0.9653 1.9384 0.0294 1.1354 3200 64 Aman 

Lt. 28 1.3216 1.1202 2.1431 0.1561 1.2443 3200 64 Aman 

Lt. 27 1.4898 1.2552 2.4012 0.3979 1.3712 3200 64 Aman 

Lt. 26 1.6632 1.3899 2.7043 0.6641 1.5173 3200 64 Aman 
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Lt. 25 1.813 1.5187 2.967 0.9088 1.6568 3200 64 Aman 

Lt. 24 1.8817 1.5851 2.8573 1.0569 1.7357 3200 64 Aman 

Lt. 23 3.1845 2.5402 3.1969 1.7757 2.8437 5600 112 Aman 

Lt. 22 2.5563 1.9522 0.2258 1.3927 2.2692 6000 120 Aman 

Lt. 21 1.0141 0.7616 0.6007 0.5266 0.883 3500 70 Aman 

Lt. 20 0.753 0.6096 0.5408 0.4021 0.6432 3500 70 Aman 

Lt. 19 0.575 0.571 0.6866 0.3122 0.4849 3500 70 Aman 

Lt. 18 0.4354 0.6011 0.6534 0.3501 0.3637 3500 70 Aman 

Lt. 17 0.3117 0.6733 0.704 0.2869 0.2581 3500 70 Aman 

Lt. 16 0.197 0.7706 0.7419 0.1921 0.1609 3500 70 Aman 

Lt. 15 0.0874 0.8752 0.7631 0.0999 0.0688 3500 70 Aman 

Lt. 14 0.0226 0.9555 0.7754 0.0072 0.0233 3500 70 Aman 

Lt. 13 0.1454 0.9572 0.7959 0.0934 0.1248 3500 70 Aman 

Lt. 12 0.3073 0.8078 0.8549 0.2204 0.2575 3500 70 Aman 

Lt. 11 1.0165 0.5817 1.673 0.7674 0.8466 5600 112 Aman 

Lt. 10 1.5014 0.3439 1.8022 1.1908 1.2665 5000 100 Aman 

Lt. 9 1.1544 1.4028 1.2148 0.9413 0.9852 3250 65 Aman 

Lt. 8 1.2367 1.6342 1.218 1.0185 1.0602 3250 65 Aman 

Lt. 7 1.2905 1.9764 1.2035 1.0639 1.107 3250 65 Aman 

Lt. 6 1.352 2.1029 1.1937 1.1103 1.1585 3250 65 Aman 

Lt. 5 1.849 2.4778 1.5372 1.5141 1.5857 4000 80 Aman 

Lt. 4 3.1293 3.9648 2.466 2.5959 2.7162 5500 110 Aman 

Lt. 3 3.6633 4.1894 2.7581 3.0905 3.2183 5500 110 Aman 

Lt. 2 3.8566 4.4483 2.7188 3.2533 3.3826 5500 110 Aman 

Lt. 1 4.0429 4.8776 2.69 3.4 3.5348 5500 110 Aman 

Lt. UG 4.3381 5.0171 2.8303 3.6591 3.8007 7000 140 Aman 

Lt. GF 0.1277 0.1489 0.0632 0.1025 0.1052 7000 140 Aman 

Lt. LG 0.0711 0.0814 0.0539 0.0629 0.0647 3250 65 Aman 

Base 1 0.0000 0.0000 0.0000 0.0000 0.0000 3250 65 Aman 
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Lampiran 5. Gambar Proyek 
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Lampiran 6.  Modul Penggunaan Softwere ETABS 

Pada penelitian model yang digunakan adalah bangunan Tower A St. Moritz 

Panakkukang berlokasi di kota Makassar. Dalam proses pemodelan terdapat 

beberapa langkah yang dilakukan sebagai berikut: 

1. Langkah pertama menentukan satuan yang akan digunakan pada kotak 

pilihan di pojok kanan bawah tampilan awal ETABS.  

 

Tampilan Awal ETABS 

2. Kemudian untuk memulai membuat pemodelan pilih menu File-New Model 

dan akan muncul pop up New Model Initialization. Pilih No untuk membuat 

pemodelan baru tanpa mengambil dari file ETABS yang telah ada di 

komputer. Option lain yang juga dapat dipilih: 

• Choose.edb untuk membuat pemodelan baru dengan definisi dan 

preferensi mengambil dari file ETABS yang ada di komputer. 

• Default.edb untuk membuat pemodelan baru dengan definisi dan 

preferensi yang sudah built-in dalam ETABS. 

 

Pop Up New Model Initialization 

3. Setelah itu muncul kotak dialog “Building Plan Grid System and Story 

Data Definition”. Ada beberapa point yang harus di input pada tahap ini 

seperti berikut:  

• Pada kotak Grid Dimention (Plan), aktifkan Custom Grid Spacing 

kemudian pilih Edit Grid. Selanjutnya muncul kotak dialog Define 

Grid Data, input jarak-jarak sumbu acuan pada arah X maupun Y. 
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Pada kotak Display Grid As ada dua pilihan yaitu Ordinates untuk 

memasukkan jarak berdasarkan sumbu koordinat dan Spacing untuk 

memasukkan jarak berdasarkan jarak dari sumbu ke sumbu. Klik 

OK dan akan kembali ke kotak dialog. 

 

Building Plan Grid System and Story Data Definition 

 

Define Grid Data 

• Pada kotak Story Dimention, aktifkan Custom Story Data 

kemudian Edit Story Data. 
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Kotak Dialog Story Data 

• Pada kotak Add Structural Object pilih Grid Only kemudian OK. 

Setelah semua proses pada langkah 3 akan muncul tampilan gambar 

sumbu-sumbu yang telah dibuat seperti gambar dibawah ini. 

 

Grid 

4. Selanjutnya menentukan material properties sesuai data perencanaan. Klik 

menu Define > Material Properties kemudian muncul kotak dialog Define 

Meterials. Untuk menambahkan material baru klik Add New Material dan 

input data material yang akan digunakan. 

 

Kotak Dialog Define Material Properties 
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Kotak Dialog Define Meterials 

Kemudian muncul kotak dialog Material Properties Data. Material 

yang digunakan adalah beton maka pada kotak Type of Design pilih 

Concrete. Masukkan data material beton sesuai desain seperti fc, fy(mutu 

baja tulangan geser), dan fys (mutu baja tulangan geser). Untuk mass per 

unit volume dan weight per unit volume biasanya defaultnya sudah benar 

yaitu 24kN/m3. Untuk modulus elastisitas dapat dihitung berdasarkan rumus 

4700√fc’. Stelah itu klik OK untuk mengakhiri. 

 

Kotak Dialog Material Properties Data 

5. Setelah itu define dimensi struktur untuk komponen balok dan kolom 

dapat dengan cara Define > Frame Section.  

 

Define Frame Section 
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• Kemudian muncul kotak dialog Define Frame Properties. Untuk 

membuat komponen struktur baru berpenampang persegi pilih Add 

Rectangular. 

 

Kotak Dialog Define Frame Properties 

• Setelah itu akan muncul kotak dialog Rectangular Section. 

Masukkan data yang diperlukan seperti jenis material, nama 

komponen, ukuran tinggi (depth) dan lebar (width) frame sesuai data 

perencanaan.  

 

Kotak Dialog Rectangular Section 

• Untuk memilih jenis frame sebagai kolom atau balok, klik kotak 

reinforcement lalu pilih frame sebagai kolom atau balok.  

• Jika ingin membuat kolom maka akan muncul kotak seperti gambar 

dibawah. Input jenis tulangan yang digunakan pada kotak 

Configuration of Reinforcement, Cover to Rebar Center (selimut 

beton), Number of Bars in 3-dir (jumlah tulangan arah y), Number 

of Bars in 2-dir (jumlah tulangan arah x) dan Bar Size (diameter 

tulangan). Setelah selesai input data klik Ok dan kembali ke kotak 

dialog Rectangular Section. 
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Reinforcement Data Column 

• Jika frame sebagai balok, kotak yang akan muncul seperti gambar 

dibawah. Input data Cover to Rebar Center (selimut beton). 

 

Reinforcement Data Beam 

• Selanjutnya pada kotak dialog Rectangular Section klik Set 

Modifier akan muncul kotak dialog Analysis Property 

Modifocation Factors dan ubah nilai Property Modifier sesuai 

dengan SNI. 

▪ Kolom : moment of inertia about 2 dan 3 axis = 0,7 

 

▪ Balok : moment of inertia about 2 dan 3 axis = 0,35 
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• Kemudian klik OK untuk mengakhiri define frame section untuk 

kolom maupun balok dan ulangi langkah tersebut jika ingin 

membuat komponen dengan dimensi yang berbeda. 

6. Setelah define kolom dan balok selanjutnya define pelat dan dinding 

dengan cara Define > Wall/Slab/Deck Section. 

 

Define Wall/Slab/Deck Section. 

• Untuk membuat pelat baru sesuai data perencanaan pilih Add New 

Slab. 

 

Kemudian akan muncul kotak dialog Wall/Slab/Deck 

Properties. Input nama pelat pada Section Name, jenis material pada 

Material, ketebalan pelat pada Thickness, dan tipe profile pelat 

berupa Menbrane.  
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Wall/Slab/Deck Properties 

Setelah itu klik Set Modifier untuk mengubah kekakuan 

pelat sesuai SNI dan akan muncul kotak dialog Analysis Stiffness 

Modification Factors. Pada kotak Stiffness Modifier ubah 

Membrane f11, f12, f13 modifier dan Bending m11, m12, m13 

Modifier menjadi 0,25. 

 

Analysis Property Modifocation Factors 

• Untuk membuat komponen dinding pilih Add New Wall pada kotak 

Define Wall/Slab/Deck Section. Beri nama wall, pilih material yang 

digunakan, ketebalan dinding, dan tipe profil berupa Shell. 

 

Wall/Slab/Deck Section 
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Seperti komponen lainnya nilai kekakuan dinding juga harus 

disesuaikan dengan SNI. Klik Set Modifier akan muncul kotak 

dialog Analysis Property Modifocation Factors dan ubah nilai 

Membrane f11, f12 Modifier dan Bending m11, m12 Modifier 

menjadi 0,7. 

 

Analysis Property Modifocation Factors 

7. Selanjutnya Define respon spektrum sebagai beban gempa. Klik menu 

Define > Response Spectrum Fuctions. 

 

Define Response Spectrum Fuctions 

Kemudian muncul kotak dialog Define Response Spectrum 

Function, klik Add User Spectrum karena tipe gempa di Indonesia tidak 

tersedia di default ETABS. 

 

Kotak Dialog Define Response Spectrum Function 
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Input data Period dan Acceleration (percepatan gempa) pada kotak 

dialog Response Spectrum IBC 2006 Function Definition sesuai dengan 

perhitungan sebelumnya kemudian klik OK untuk mengakhiri. 

 

 

Kotak Dialog Response Spectrum IBC 2006 Function Definition 

8. Menentukan spektrum gempa dengan klik menu Define > Response 

Spectrum Case. 

 

Define Response Spectrum Case 

Kemudian muncul kotak dialog Define Response Spectrum klik Add 

New Spectrum. Input data pada kotak dialog Response Spectrum Case Data 

seperti Spectrum Case Name berupa RSPX dan RSPY. Input Response 

Spectrum untuk arah X isikan Function dan Scale Factor pada kotak U1 

sedangkan untuk arah Y isikan pada kotak U2. 
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Kotak Dialog Define Response Spectrum 

 

 

Kotak Dialog Response Spectrum Case Data 

9. Menentukan beban yang akan bekerja pada bangunan dengan mengklik 

Define > Static Load Case.  

 

Define > Static Load Case. 

Kemudian muncul kotak dialog Define Static Load Case Names. 

Input jenis-jenis beban yang akan diaplikasikan pada bangunan untuk proses 

analisis pada kotak type .Klik Add New Load untuk mambuat jenis beban 

yang tidak tersedia pada kotak type.  
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Kotak Dialog Define Static Load Case Names 

10. Menentukan kombinasi pembebanan dengan mengklik Define > Load 

Combination. 

 

Define Load Combination. 

Kemudian muncul kotak dialog Define Load Combination setelah 

itu pilih Add New Combo. Selanjutnya mucul kotak dialog Load 

Combination Data masukkan scale factor setiap jenis beban pada masing-

masing kombinasi yang telah direncanakan. 

 

Kotak Dialog Define Load Combination 
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Kotak Dialog Load Combination Data 

11. Menggambar komponen struktur pada bangunan, dapat dimulai dengan 

menggambar kolom dengan cara pilih menu menu Draw > Draw Line 

Object > Create Columns in Regions or at Click. 

 

Draw Colomn 

 

Kemudian muncul kotak Properties of Object untuk menentukan 

dimensi kolom yang akan digunakan dapat dipilih pada Properties. 

Kemudian klik satu kali untuk menempatkan kolom sesuai gambar denah. 

 

Properties of Object 

12. Menggambar balok, klik menu Draw > Draw Line Object > Draw Line. 

Kemudian muncul kotak Properties of Object, dimensi balok dapat dipilih 

pada Properties. Klik titik awal balok dan klik lagi pada titik akhir  balok 

dengan acuan garis grid yang dibuat sebelumnya. 
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Draw Line 

 

Properties of Object 

13. Menggambar pelat, klik menu Draw > Draw Area Object. Kemudian 

muncul kotak Properties of Object, dimensi pelat dapat dipilih pada 

Properties. Klik titik titik yang mengelilingi pelat dengan acuan garis grid 

yang dibuat sebelumnya. 

 

Draw Area Object 

 

Properties of Object 

14. Menggambar dinding atau wall, klik menu Draw > Draw Area Object > 

Draw Walls. Kemudian muncul kotak Properties of Object, jenis atau 

dimensi wall dapat dipilih pada Properties. Klik titik awal wall dan klik lagi 

pada titik akhir wall dengan acuan garis grid yang dibuat sebelumnya. 

 

Draw Walls 
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Properties of Object 

15. Define beban yaitu beban mati dan beban hidup, Pilih pelat yang akan diberi 

beban kemudian pilih menu Assign > Shell/Area Loads > Uniform.  

 

Assign Shell/Area Loads 

Setelah itu muncul kotak dialog Uniform Surface Loads pilih Load 

Case Name antara Dead/Live sesuaikan dengan jenis beban yang kan 

diinput. Input nilai beban pada kotak Load dan perhatikan satuan yang 

digunakan lalu klik OK untuk mengakhirinya. 

 

Kotak Dialog Uniform Surface Loads 

 

16. Menentukan jenis perletakan pada bagian dasar struktur. Select semua titik 

pada lantai base kemudian pilih menu Assign > Joint/Point > 

Restraint/Support. Akan muncul kotak dialog Assign Restraints pilih jenis 

support yang akan digunakan lalu klik OK untuk mengakhiri. 
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Assign Restraints Support 

 

Kotak Dialog Assign Restraints 

17. Setelah seluruh langkah pemodelan komponen struktur selesai langkah 

selanjutnya adalah proses analisis dengan klik menu Analyze > Set Analysis 

Options. 

 

Menu Analyze 

Kemudian muncul kotak dialog Analysis Option pilih Full 3D pada 

Building Active of Freedom dan checklist pada Dynamic Analysis lalu klik 

OK. Langkah terakhir pada menu Analyze pilih Run Analysis. 
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Kotak Dialog Analysis Option 

 

Menu Analyze 
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Lampiran 7. Surat Administrasi  
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